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1. Introduction
Main window

Main window contains Map View and Side Bar.  Map 
View draws colored elevation map depends on Digital 
Elevation Model (DEM) data. Side Bar contains Map Info 
Panel  and Index Map.  Map info panel  shows kind of 
DEMs, scale, Color Set and others.  Index Map shows 
current position in world map where Map View show-
ing.

Main window always exists on the screen during Sim-
pleDEMViewer running. You can hide Side bar anytime.

Draws maps colored by elevation
Reads various DEM data, and makes map colored by elevation with or without shading. It sup-

ports gradation color also. 
• Draws Parallels and Meridians.
• Shows latitude, longitude and elevation at 

the mouse point.
• Draws contours calculated using DEMs.
• Support various DEM data available at on-

line sites. See below.
• Makes maps with several projection 

methods. See below.
Two  pictures  at  right  show  maps 

around Mt. Fuji in Japan using SRTM 3 
seconds mesh DEMs with shading.

Supported DEM files
Followings are supported. Refer next section。

• GTOPO30 ( 30 sec. )
• ETOPO1 ( 1 min. with sea depth, Treated as BIL form )
• ETOPO2 ( 2 min. with sea depth )
• ETOPO5 ( 5 min. with sea depth )
• GLOBE ( 30 sec. )
• SRTM (1 sec., 3 sec. )
• SRTM DTED (1 sec., 3 sec. )
• USGS ascii ( Geo and UTM )
• USGS SDTS ( Geo and UTM )
• 1km / 250m / 50m / 10m / 5m / 2m DEMs from GSI of Japan  

<AS note> No support of 10m / 5m / 2m DEMs those have file extension ‘LEM’.
• BIL form DEM ( with address boundary or no addressing )
• ASTER GDEM ( 1 sec. / GeoTiff )
• JAXA ALOS ( 1 sec. / GeoTiff )
• GeoTiff DEM
• netCDF DEM (GMT compatible format )
• PDS DEM ( Planetary Data System form NASA. File extension is ‘IMG’ )
• ArcAscii DEM files ( Geo and UTM )
• HYDRO1k ( no address data )

Customizable items
• Elevation colors and its boundaries.
• White Antarctica and Greenland.
• Gradation colors.
• Lakes. Its color.
• Shading, light direction, shade strength.
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• Shrink or expanding rate ( between 2000% and 5% )
• Color, line width and intervals of Parallels and Meridians.
• Adjust horizontal scale depending on latitude, so that horizontal and vertical scale will be the same.
• Others.

Other functions
• Making lake data.
• Drawing contours.
• Coloring by slope degrees.
• Texture Mapping.
• Drawing bird's-eye View pictures.
• Drawing stereograph pictures.
• Drawing SRVC relief maps.
• Drawing panorama view pictures.
• Go through landscape, 3D movie.
• Drawing visible region.
• Drawing geo-profile pictures.
• Drawing grayscale map pictures.
• Drawing Orthographic projection maps.
• Drawing Conical projection maps.
• Drawing Mercator projection maps.
• Drawing Equidistant projection maps.
• Drawing Equi-area projection maps.
• Drawing Universal Transverse Mercator ( UTM ) projection maps.
• Drawing Lambert Conformal Conic projection maps.
• Saving pictures as picture files in various formats.
• Creating and drawing memos, routes and areas on maps.
• Reading some external format data and draw them as user memo, route and area data.
• Export user data to text file and import them.

Datum
  Always WGS84 is used, but calculations of distance and direction are based on a sphere its radius is 6371 
km.
  Even if DEMs stand on other than WGS84, SimpleDEMViewer uses WGS84 always, therefore you should 
aware of the datum of your data.  One exception is Tokyo datum of older DEM files from GSI of Japan, their 
addresses are converted to WGS84 automatically.

Projection method
  Projection method depends on DEM data type.  When multiple type of DEMs are read, projection method 
of the narrowest pitch DEM is used.
Geo DEMs
Longitude / Latitude coordinate ( Equidistant Cylindrical projection ).  You can adjust horizontal axis to re-
duce distortion of the map depending on latitude.
UTM DEMs
UTM of course.
XY plane of Japan DEMs
Rectangular Plane Coordinate system defined in Japan.
Other plane DEMs
  Here, "Other plane" means any Transverse Mercator projection plane other than UTM and plane of Japan.  
You can define worlds local plane coordinate system such as NZTM2000 and CH1903+, etc..  They should 
stand on Transverse Mercator Projection like as UTM.  It is applicable for BIL and ArcAscii DEMs.  See 
“Manage Projection Planes”
  GeoTiff DEMs using other plane are also supported.  To determine coordinate system of the DEMs, Sim-
pleDEMViewer access internet site.
  If you do not know the coordinate system of your DEMs, you can use them without addressing called 
General Plane DEM in this program.  Such DEMs can be arranged in the Map View, but could not link with 
any other data including other DEMs, User Data and texture maps.
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No addressing DEM
No projection.  No link with latitude and longitude.  Only one DEM file can be shown on the Map View.

Planets and the Moon
  Supports DEMs for planets and the Moon using PDS or bil form DEMs.  Refer BIL form 
DEM data section for BIL form DEMs. 
  All calculations are based on specified radius.  Coordinate system should be geo-refer-
enced.  Following functions are not supported for planet DEMs. 

• Drawing UTM projection map.
• Drawing white Antarctica and Greenland.
• Drawing sea and the Sun in panorama views.
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2. Elevation Data
You should prepare at least one of following elevation data (DEM) separately.
All DEM data are treated as datum is WGS84 except older DEMs from GSI of Japan.

GTOPO30, HYDRO1k
Their data interval is 1 km nominally. GTOPO30 is bounded by Latitude and Longitude. HY-

DRO1k requires header file (it's file extension is HDR).
You can download both at Elevation data site of USGS.

ETOPO1, ETOPO2, ETOPO5, GLOBE
They are 1, 2, 5 minutes and 30 seconds mesh data. First three have bathymetry data, and cov-

ers whole world by one file. ETOPO1 provided as BIL  or GeoTiff,  and SimpleDEMViewer treats 
them as BIL or GeoTiff.

You can download them at National Geographical Data Center (NGDC).

SRTM 3sec/1sec
This data is obtained by Space Shuttle. It is bounded by Latitude and Longitude. Its data interval 

is 3 arc seconds or 1 arc seconds. Refer to Shuttle Radar Topography Mission (SRTM) site.
You can download them from above SRTM site in its original format (its file extension is HGT), 

or in BIL format.

SRTM DTED level 0/1/2 ( 30 sec / 3 sec / 1 sec )
"Finished" data derived from SRTM. Sea surface and some lake surfaces are flattened. You can 

order data SRTM site on DVDs.

SRTM30plus
30 seconds mesh DEM derived from SRTM, and has bathymetry data. First 7 characters of the 

file name should be same as those of GTOPO30, and file extension should be "SRTM".

USGS ascii
You can download various elevation data in this format from USGS or some other data centers. 

Supports geo and UTM data. File extension should be “DEM”.

USGS SDTS
You can download various elevation data in this format from USGS or some other data centers. 

File extension is always DDF. One DEM data consists of several files, although open dialog can 
select xxxxCEL0.DDF file only.

<AS note> You should select a folder instead of a file.

1km / 250m / 50m / 10m / 5m / 2m DEMs from GSI of Japan
Sold in CD-ROM only for Japanese region. You can purchase from Japan Map Center (JMC).
<AS note> No support of 10m / 5m / 2m DEMs.

BIL FORM DEM
Supports 8 or 16 bits integer and 32 bits float format. Supports geo and UTM addressing. Sup-

ports elevation values in meters or feet. Refer next section.
You can download various elevation data in this format from USGS and other GIS data sites.

ASTER GDEM
One of GeoTiff form DEM. The data pitch is 1 arc-second.
You can download data from https://gdemdl.aster.jspacesystems.or.jp/index_en.html
Now, Version 3 includes ASTER Water Body Dataset (ASTWBD).  This program refers only the 

ocean data from the attribute file.
<AS note> You should select the folder that includes both data to recognize ASTWBD files.
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JAXA ALOS World 3D-30m
One of GeoTiff form DEM. The data pitch is 1 arc-second. Paired mask file has sea area infor-

mation. If no mask file exists in the same folder, the file is treated as general GeoTiff DEM.
http://www.eorc.jaxa.jp/ALOS/en/aw3d30/
<AS note> You should select a folder instead of a file.

GeoTiff DEM
Supports 16 bits integer and 32 bits float format.  Unit is meter or feet for elevation.  Supports 

geo and UTM and other plane DEMs.  If its plane is listed in the table of Plane Manager, it is rec-
ognized automatically.  If it is not listed, it will be registered there with temporary name.

If the projection method is not Transverse Mercator or cannot be recognized, a dialog will appear to ask 
you which plane should be taken. In that case, you should select "General" usually.

SimpleDEMViewer accesses internet site to determine projection method if EPSG code is specified in the 
DEM without other detail.  Once it is recognized, it will be saved and no more internet access required.

Datum is ignored, all are treated as WGS84.  Be aware of it if use them with other data.
<AS note> You can select any tiff format file by Open panel, error message will be shown after closing 

the panel if those are not DEM file.

Arc Ascii DEM
Arc/Info's exported text format DEMs. Supports geo, UTM and other plane DEMs.  If UTM or other 

plane DEMs, will ask zone number or what plane.  Elevation value should be in meters. File exten-
sion should be ‘ASC’.

If you specify 0 for zone number, the DEM will be treated as “General plane DEM”, that means 
no link with latitude and longitude.

You can download SRTM 3 sec ver.4 in this format at the CGIAR-CSI site.

netCDF DEM
GMT compatible netCDF format DEM files are supported. File extension should be ‘GRD’.
<AS note> You can select any file that has file extension ‘GRD” by Open panel, error message will be 

shown after closing the panel if those are not DEM file.

PDS DEM
Planetary Data System DEMs are derived from NASA space data.  The Moon, Mercury, Mars and some oth-

er celestial bodies data are provided as DEM files.  File extension should be ‘IMG’.  In case a separate label 
file, its file extension is ‘LBL’, is attached, it should exist in the same folder.

<AS note> You can select any file that has file extension ‘IMG” by Open panel, error message will be 
shown after closing the panel if those are not DEM file.

DEMs for KASHMIR
Dedicated format for KASHMIR 3D with the file extension 'dcm'. ( KASHMIR 3D is a program for 

MS Windows. )

BIL form DEM data

Requirements
• Each elements is 16 or 8 bits integer with sign bit, or 32 bits float. Supports Motorola and Intel byte order 

which is specified in header file. Default is Motorola format.
• Elements are stored in row major order (all the data for row 1, followed by all the data for row 2, etc.).
• Data interval is in degrees or seconds. Meters for UTM or no addressing DEMs.
• Each value is in meters or feet.
• No LF nor CR characters.
• File extension should be BIL DEM or FLT. If FLT, data element should be 32 bits float.
• File size should be equal to "number of columns" times "number of rows" ( times 2 if 16 bits element or 

times 4 for 32 bits float ) described in header file.
• Header file must be exist in same folder.  Its file name is same as elevation data but file extension.  Its file 

extension should be HDR.
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• Optionally BLW file is used to determine boundary addresses. Its file name is same as elevation data but 
file extension BLW.

• -9999 in elevation value means sea, except when 'NODATA -9999' specified.

HDR file (text file)
This file should describe followings. Other items are ignored.  

Specify one entry in one line. Each line has a key and a value pair. Result has no guarantee if con-
flicted entries are specified.

Keys Values
NROWS number of rows
NCOLS number of columns
NBITS number of bits per element, 8 or 16 for integer, 32 for float. Can be omitted if file 

extension is FLT.
<followings are optional>

BYTEORDER If ‘I’ or ‘LSBFIRST’ is specified byte order is Intel, otherwise Motorola.
UTMZONE UTM zone number between 1 and 60, or -1 and -60 for south. Specify only if addresses 

are based on UTM.
XYPLANE Plane ID defined in Manage Planes panel, or plane number of Japanese 19-

rectangular plane coordinate system.
If Plane ID contains space, enclose them with double quotation marks.
If 0 is specified, it means general plane coordinate system.

ULXMAP Longitude at the center of the north-west corner cell of the data in degrees, or UTM Y 
address. X address for other plane coordinate system in meters.

ULYMAP Latitude at the center of the north-west corner cell of the data in degrees, or UTM X 
address. Y address for other plane coordinate system in meters.

XLLCORNER Longitude at the lower-left corner of the south-west corner cell of the data in degrees, or 
UTM Y address. X address for other plane coordinate system in meters.

YLLCORNER Latitude at the lower-left corner of the south-west corner cell of the data in degrees, or 
UTM X address. Y address for other plane coordinate system in meters.

XLLCENTER Longitude at the center of the south-west corner cell of the data in degrees, or UTM Y 
address. X address for other plane coordinate system in meters.

YLLCENTER Latitude at the center of the south-west corner cell of the data in degrees, or UTM X 
address. Y address for other plane coordinate system in meters.

XULCORNER Longitude at the upper-left corner of the north-west corner cell of the data in degrees, or 
UTM Y address. X address for other plane coordinate system in meters.

YULCORNER Latitude at the upper-left corner of the north-west corner cell of the data in degrees, or 
UTM X address. Y address for other plane coordinate system in meters.

XULCENTER Same as ULXMAP
YULCENTER Same as ULYMAP
(Notes) Above five sets (ULXMAP/ULYMAP, XLLCORNER/YLLCORNER, XLLCENTER/

YLLCENTER, XULCORNER/YULCORNER, XULCENTER/YULCENTER) are 
exclusive. If mixed, result is undefined.

XDIM Horizontal data pitch in degrees or seconds. If it is greater than or equal to 0.1, it is in 
seconds.  For UTM and other plane DEMs, value is in meters.

YDIM Vertical data pitch. value is same form as XDIM.
CELLSIZE Data pitch for horizontal and vertical. Don’t specify XDIM and YDIM when this entry 

exists.
SEALEVEL If data has special value for sea area, specify it. -9999m is assumed if not specified here 

and NODATA is not -9999m.
NODATA If DEM file has no-data ( void )-value, specify it.
NODATA_VALUE Same as NODATA.
ELEVATIONUNIT Specify 'F' if elevation is in feet, otherwise omit this.
SKIPHEAD If data has extra bytes in the beginning of the file before elevation elements, specify 

number of bytes to skip.
SKIPBYTES Same as SKIPHEAD
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If addressing values are outside of geo address range ( i.e. -180 to 180 and -90 to 90 ) and no 
UTMZONE nor XYPLANE is specified, ‘XYPLANE 0’ is assumed.

If four lines from ULXMAP to YDIM are not specified here and no BLW file is found, the DEM data 
will be treated as no address data.

<Example 1>
 BYTEORDER     I
 NROWS         3600
 NCOLS         3600
 NBITS         16
 ULXMAP        -115.000138888
 ULYMAP        35.999861111
 XDIM          1.00000
 YDIM          1.00000

<Example 2>
 byteorder       lsbfirst
 nrows         3601
 ncols         3601
 nbits         32
 cellsize      1.0
 xllcorner     -114.99986111
 yllcorner     35.99986111

BLW file (text file)
This file should describe following data in this order. Each line should have only one floating 

point number in text format.

<Example> 1 second mesh
0.000277777777778
0.0
0.0
-0.000277777777778
110.000138888889
39.9998611111111

RADIUS Specify radius of the Moon or a planet other than the Earth in kilometer. 
Instead of radius you can specify planet name for Moon, Mercury, Venus or Mars. 
If this entry is specified, coordinate system should be geo-referenced, otherwise DEM 
file is ignored. If you specify radius of the Earth, program assumes some planet other 
than the Earth.

Lines Values
1 Same as XDIM value.
2 ( Ignore )
3 ( Ignore )
4 Same as YDIM value, but always minus.
5 Same as ULXMAP value.
6 Same as ULYMAP value.
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3. Read Elevation Data
Read data

“File” => “Open” menu shows file selection panel.  You can read elevation data by selecting in-
dividual files or folders through the panel.  If you select a folder or folders, program reads all 
readable files in them.  If files to be read are not compatible with files already read and showed in 
the Map View, an alert prompts you to dispose read data or cancel new reading.

If “Read two levels when folders selected.” is checked, read files in folders those are in the fold-
er you selected.

SimpleDEMViewer reads DEM files when you double click DEM files in Finder, or drop them on to 
application icon. Application icon accepts folder that contains DEM files.

Different format DEMs can be read and be laid in the Map View as described in next section.  
UTM and other plane DEMs can be read at the same time if they are belong to the same UTM zone 
or plane.

<AS note> You should select folder for SDTS and JAXA ALOS instead of individual files.

Coexistence of different kind of DEMs
If several kind DEMs are read, map scale is based on the smallest pitch DEMs.  The coordinate 

system is also determined by them.  If it is UTM or other plane DEMs, whole map will be UTM or 
other plane coordinate.

If the coordinate system is UTM or other managed planes, map area extend up to 667 km. Loca-
tion leaves far from center meridian more than 6 degrees, accuracy getting worse.

DEMs of different planets cannot coexist.

Start up time restoration
As a default, program restores DEMs and settings at starting if previous session ends without 

removing data.  See “Save and restore working set” section.
To skip-restore function, start program with shift key pressing.

Read as named working set
You can read previously defined DEM data set anytime with various settings. See “Save and 

restore working set” section.

Remove data
To remove read data, select "File" => "Remove data" menu, and select data to remove. If you 

read new DEMs without removing current data, and they are not compatible, you will be prompt-
ed to remove read data or cancel new reading.

16



SimpleDEMViewer

4. Map Handling
Scaling

From scale menu or context menu, you can select scale between 2000 and 5% or specify values 
directly in "other" menu.  If you change the scale using Scale menu, center of the Map view keep 
its position.  If you change it from context menu, mouse point will move to center of the Map 
view.

Scaling by pinch action on a track pad, in this case place at the mouse point retain its position 
in the Map view.

Map is centered in the Map view if scale is small enough to show all the world, or all the DEMs 
in case of UTM or other plane DEMs 

Other Scale menu
If you select other scale menu, a dialog will be displayed and you can specify any scale as fol-

lows in the dialog.
• Any percentage to data between 5 and 2000 percent.
• Specify milage in meter, km, yard or mile to data pixel, cm or inch on the map.
• Specify scale by fraction directly like as 1 / 1000000.

For second and third case, click calculate button after entering value, so that result scale will be 
set to the percentage field.  In this case although only three decimals are displayed in the field, 
more significant decimals are kept.

Reposition map by address ( Jump to )
You can reposition the map to any place specified 

by latitude and longitude.  Select "Find&Jump" => 
"Jump to…"  menu to  display  dialog,  and  specify 
latitude  and  longitude.   You  have  an  option  to 
draw a mark at the place after repositioning.

You can save the address with a name to reuse 
later, they will appear in a place menu of the dia-
log.

You  may  copy  latitude  and  longitude  in  some  web  page  and 
paste it to address field here.  Picture at right from USGS earth-
quake information page shows address consists  of  latitude and 
longitude.  Any non-numeric characters are ignored but N, S, E, W.  
Refer to “Copy / Paste latitude & longitude” section.

Reposition map by searching user data string
You can search a user data by string in title or node comment, and reposition the map so that 

the found data is positioned in the center of the window.  Refer to "Find user data on the map" 
section.

Reposition map using Index Map
You can reposition map to any place specified in Index map by dragging showing frame or dou-

ble-clicking at any place in theIndex map. Refer “Index Map” section.

Scrolling
Supports drag scrolling and scrolling by wheel mouse or scroll gesture on a track pad.  You can 

scroll one dot by pressing arrow keys.  If retina display is used, scroll two pixels.
If DEM has geo address, you can rotate map horizontally around the world.
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Resize map window
You can set Map view size by pixels.  Select "View" => "Window size…" menu to display a dia-

log, specify width and height.  Those values are applied to the Map view without window frame, 
title bar and side bar.

You can drag the resize one of edges to change window size as usual.

Showing address and elevation value
Move mouse on the Map View with option key pressing 

to show latitude,  longitude and elevation at  the mouse 
point.  Its elevation value is nearest cell value of DEM file 
or interpolated which you can select in Preferences panel.

Elevation value is shown in integer if DEM format is inte-
ger, otherwise it shows one decimal place.  Instead of ele-
vation value it shows "sea" for sea, "void" for void value, or 
"n/a" for out of DEM.

DEM information
Select "Show Info" under File menu to show informations 

about read DEMs.  If there are multiple types of DEMs are 
read, their types / data pitches / number of files will be 
shown for each.  It also shows the scale and address of 
the center of the map region.
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5. Map Info Panel
Map Info Panel  shows current  DEM data type,  scale,  shading 

type and color set.  You can change shading type, strength and 
color set from here and it affects map instantly.

Showing items
DEM data type Type of DEMs currently showing.  If they are UTM type, 

shows zone number, and plane ID for DEMs defined in 
Manage Planes panel.

Scale Percentage of extending or shrinking rate based on one data 
cell to one pixel ( if retina display, 4 pixels ) on the screen.
Also shows  1 / n  style fractional number assuming that 
screen has 72 pixels per inch or 144 pixels per inch if retina 
display.

Base latitude Base latitude for geo-referenced DEMs.
Lon / Lat Intervals of Meridians and Parallels. If they are same value, 

shows only one.
Shading Shows shading type. You can change it by popup menu.
Strength Shows shading strength. You can change it by popup menu.
Color set Shows current color set with color set menu. you can select 

color set here.

Operations
• “Show / Hide Side Bar” under the “View” menu shows or hides side 

bar of the main window including Index map.
• Changing shading or color set in this panel affects map view immedi-

ately.
• Changing settings here affects Preferences settings also.
• “Edit color set” button shows a dialog to edit color set.
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6. Index Map
Content

Index map resides at the bottom of the side bar.  Index map dis-
plays part  of  world map,  and shows area displayed in the Map 
View.  White rectangular frame shows area displayed in the Map 
View.  Index map shows the area that DEMs are read with deep 
colors and pale colors for other area.  When index map is expand-
ed it shows international boundaries.

You can make the height of Index Map view to half size, to do so 
drag upper edge of the view.

Index Map is not available for DEMs those have no addresses.

Scale of the Index Map
Depends on displayed region in the Map View, Index Map shows almost whole world to smaller 

area automatically.  Based on smallest map, expands up to 64 times, or 256 times around Japan.  
Although each pixel of map has same size in degrees for horizontal and vertical dimensions in 
smaller maps, pixel  width in degrees shrinks depends on center latitude for more expanded 
maps so that pixel width and height in kilo meters are the same at the center.  International 
boundaries will be drawn in expanded map larger than 8 times.

Although scale of the index map is automatically adjusted, you can change it temporarily by 
pressing [+] or [-] button, [+] button zooms in twice and [-] button zooms out half.

Following five pictures are 1, 2, 4, 8 and 16 times scaled Index Maps.

DEM range and Map View range
As pictures at top and at right, read DEMs region is drawn in deep 

color in each DEM region.  Each DEM region defined with four corners 
addresses, region has no elevation values in the DEM are ignored.  
White frame represents region that Map View shows currently. It is 
always rectangle for geo-referenced DEMs, but trapezoid for UTM or 
other plane DEMs like as picture at right, even so, DEM read area is 
rectangle for each DEM always.
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Index Map will be rescaled and repositioned automatically when the Map View is rescaled or 
repositioned, so that white frame always be placed at the.center of the Index map.  If white frame 
is small enough, Index Map will be expanded automatically, but maximum scale is 64 / 256 then 
frame may seem like a dot.

Operations on Index Map
Show / hide index map can be done by "Show / Hide Side Bar" under the "View" menu.
You can move Index map content temporarily by dragging map at outside of the white frame.  It 

will be reset to default state when the Map view is redrawn.
You can enlarge index map up to 64 / 256 times.  [+] button extends twice and [-] button 

shrinks to half.
You can change the Map View position using Index Map.  To change map position, place mouse 

pointer inside the white frame and drag it, release button where you want to show in the the Map 
View.  Double clicking any place in the index map redraw map view as the clicked place will be 
the center of the map view.
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7. Map Settings ( Preferences )
You can specify colors, shading and other settings in "Preferences" di-

alog. Select “Preferences…” under the application menu to show the di-
alog.

Elevation colors
• Elevation color table is like a picture at right.  Elevations are boundaries be-

tween colors in same row and next.  You can change all colors and boundary 
elevations, sea color and lake color.  Click each color box to change it's color 
or each elevations to change boundary elevation.. You can specify float val-
ues for boundary elevations in unit of meters.

• Number of elevation colors are variable between 3 and 30.  Clicking [+] button 
adds a row before selected row.  If none selected, adds one at top.  Clicking [-
] button removes selected row.  You can not remove bottom row.

• Any place has elevation between boundaries are colored with its color. Places 
having elevations equal to boundary elevation, take upper side color when 
elevation is greater than 0 m, otherwise take lower side color.

• Sea color applied when elevation value is specified as sea, usually -9999 m is 
specified.  
No sea color applied to ETOPO1 / ETOPO2 / ETOPO5 / SRTM plus and 
GEBCO since no sea level data exist.

• If gradation is on, colors are changed gradually from one elevation color to next elevation color.  Take 
specified color when the elevation is mid of two boundary elevations.  Gradation will not be applied if 
boundary elevation is 0 meter.  Highest and lowest part are also exception.

• Although you can edit color set here, you can use separate dialog to do it, click "Edit in separate window" 
button.  Refer "Edit Color Set"

Vacant color
Color for the region where no elevation data exists.
Select from white, black or sea color.  Sea color varies depending on color set.

Use gradation
Check if you want to draw elevation colors with gradation.

White Antarctica and Greenland
Make Antarctica to be white.  Some low elevation outskirt of the land are de-

pends on elevation colors.
Area over 1300 meter elevation on Greenland are drawn with white color.  Pic-

ture at right is Greenland using ETOPO1 and etopo color set.

Fill land of zero meters or less with a color just above zero meters.
When using a color set with seabed color like the “etopo” color set, draw the color of the land 

lower than the sea level with the color just above 0 meter.  However, in the case of the Caspian 
Sea it is applied only for area shallower than 28 meter, area deeper than it is drawn with the orig-
inal elevation color.

Target places are only followings.
Caspian sea.  Dead sea.  Northern lower land of Egypt,  Libya 

and Algeria. Eritrea, England ( about 120 km north of London ). 
Salton Sea and Death valley U.S.A. Lake Eyre Australia. Turpan 
Basin China. Nagoya and Niigata Japan.

Do not turn on this switch if you use color set its color of zero 
meter or less is land color.

Picture  at  right  is  a  sample  drawing  of  Caspian  Sea  using 
ETOPO1 and “etopo” color set. 
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Draw lakes
Check if you want to draw lakes with lake color.  You should create lake data to draw lakes for 

each DEM kinds.  Refer to section “Drawing lakes”.

Treat 0 meter as sea if DEM does not specify sea level
Some types of DEMs have sea area as 0 meter.
Be aware that inland 0 meter area also be treated as sea.
This option applied to DEMs when they are read when this option is on, no effect to DEMs al-

ready be read.
GDEM version 3 has ASTWBD file and this program refers the sea information from that, then 

this function is not applied when ASTWBD file is available.

Treat sea as no data region
Some DEMs have void or vacant area within their rectangle region.  SimpleDEMViewer searches 

other DEMs to fill those region.  If you check this option, sea area is treated as vacant area, so 
that you can draw land part of GTOPO30 and sea part of ETOPO1 for example.  Set to off usually 
because of performance.

Color sets
• A color set includes elevation colors, lake and sea colors, boundary elevations.
• You can create new color sets with names, they will appear in color set menu.
• You can delete named color sets created by user.

Shading
• Select one of “No shading”, “By light”, “By slope” and “Both”.
• Strength has eight levels. 8 is most deep.
• You can select light direction from 8 direction menu when “By 

light” or “Both”.  Elevation angle is always 45 degrees.
• If “Both” you can select strength of shading by light between 1 

and 5.
• If DEM has no address, assume upside towards north.

The picture below shows sample of each effect, left is by 
light, center is by slope, right is by both. DEM is 1/3 sec-
onds NED of Grand Canyon.

Parallels and Meridians
• Select line interval between 30 degrees and 1 minute or automatic. 

Default is automatic. You can select different intervals for parallels and meridians.
• Select line color using Color Picker.  Default is black.
• Specify line width in points.  Default is 1 point. Float value is acceptable.

If the coordinate system is UTM or other managed planes, meridians will be drawn up to 10 de-
grees apart from base meridian for both side, but location accuracy getting worse if it leaves 
more than 6 degrees.
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Base latitude
By default, each pixel of map has same size in degrees for horizontal and vertical dimensions, 

therefore pixels not on the equator are expanded horizontally wider as far from the equator. If 
your map is in larger scale ( e.g. SRTM ) and you want to look around high latitude region, you 
can specify "Base latitude" to compensate this effect.  Aspect ratio will be normalized at specified 
"Base latitude".

If you use SRTM 3 seconds data and draw in 100%, each pixel represents 3 arc seconds in both 
latitude and longitude.  It  will  be 6 
arc seconds in longitude when you 
specify 60 degree as "Base latitude". 
"Base latitude" should be between 0 
and 60.

"Set  to  current  map  center"  sets 
base latitude to latitude of Map View 
center,  but  still  restricted  to  60.  
“Adjust  Base  Latitude”  under  the 
View menu does the same thing.

Unit of milage
Specify unit of milage from "km", "mile" or “nautical mile”.
Scale panel, Milage measuring, Route data milage, Geo-profile and Panorama view support it.

Address format to copy
Select address format to copy from D.M.S or degrees.  It affects copy address on the Map View 

and address view in any dialogs.
D.M.S LW N12.34.56.789 W123.45.54.321
DD 12.58244414 -123.7650892

Showing elevation
You can show latitude, longitude and elevation value at the mouse point on the Map View by 

moving mouse with option key pressing.  You can select elevation value of nearest DEM element 
value or interpolated value.  Interpolated value may exceed data value and actual elevation for 
peeks.

Restore working set
Specify whether always restore status at start-up or only when user save the status manually at 

previous session.
Refer to “Save and restore working set” section.

Lake data folder
• Specify a folder to save lake data. 

Default folder is "~/Library/Application support/jp.jizoh/SDVr7/Lakes/“. 
<AS note> “~/Library/Containers/jp.jizoh.SDVrAS/Data/Library/Application support/jp.jizoh/SDVrAS/Lakes/“.

• If you want to add lake data, you should have right to update the folder, otherwise you can share the lake 
data with other users.

Create world file
Specify to create a world file when saving grayscale map or stereograph as a file if available. See 

“Save pictures” section for conditions and file format.

High density drawing
When using Mac with retina display, you can specify to create high density map to fit retina dis-

play. It makes map drawing little slower. Contour line get thinner and its drawing takes almost 
four times, also drawing Visible Region is same as such.
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You should specify 144 dpi when saving picture, if you want a high density Map View picture.

Other buttons
Reset Set all values in this dialog to program's default values except high density drawing and lake data 

folder.
Redraw Redraw the Map View contents with current settings.  Without clicking this button, latest settings will 

be applied at next drawing.
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8.Manage Projection Planes
Define world’s local planar coordinate systems which should use Transverse Mercator Projection 

like as UTM.  Those systems should based on WGS84.
Coordinate systems defined here are identified by “Plane ID” you specified.  You can refer Plane 

ID when reading some kind of DEM files.

Dialog
Select  “Manage  Projection  Planes” 

under the File menu to show this dia-
log.

There  are  two  predefined  planes, 
“CH1903+” of Swiss and “NZTM2000” 
of New Zealand as examples.  You can 
remove them if you want.

Plane ID Any characters to identify 
planes.

Base Address Origin address of the 
coordinate plane in lati-
tude and longitude.

False Northing Y coordinate address at the 
origin.

False Easting X coordinate address at the 
origin.

ScaleFactor Scale factor at the central 
meridian, between 0.9990 and 1.0.

Comment Any comment, will be shown at selection dialog when reading DEMs.

How to use
ArcAscii DEMs

Select from the plane menu in the selection dialog 
at reading time.
Bil form DEMs

Specify XYPLANE entry with Plane ID in the HDR 
file.

XYPLANE      CH1903+
If Plane ID includes spaces, use double quotation 

marks.
XYPLANE      “Swiss Projection”

Automatic register for GeoTiff
When reading GeoTiff DEM files, if their projection method is Transverse Mercator but not UTM, 

its projection plane will be registered here if not exists.  In that case, it has temporary name as 
"Temp_Plane-n", n is serial number here.  EPSG code and its name will appear in comment field.

It is temporary registration, and will disappear after quitting program.  If you want to keep it, 
change the plane ID to your desired name.

If projection method is Oblique Mercator but both axis are at right angle, it will be registered 
here as it is same as Transverse Mercator practically, such as "EPSG:2056, Swiss Oblique Mercator 
1995".
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9. Edit Color Set
Although editing color set is available in the Preferences panel and Panorama View dialog, this 

separate editing dialog provides more convenient way especially to create new Color Set with 
many number of colors.

"Edit Color Set" button in Map Info Panel shows this dialog, "Edit in separate window" in Prefer-
ences panel and Panorama View dialog shows this dialog also.

Dialog
Content at first

Content  shows  the  Color  Set  that  is 
shown in  caller  dialog  at  first,  but  you 
can refer any Color Set by selecting Refer 
menu.  If caller is Panorama dialog, sky 
colors are shown also.

Elevations are boundaries between col-
ors in same row and next.
Number of colors
• Maximum number of colors is 30, minimum 

is 3 except sea, lake and sky colors.
• [+] button adds a row at selected row.  Its 

elevation and color are set to new row.  If 
more than one row selected, the row clicked 
last is the target.

• [-] button removes selected rows except 
bottom row.

• You can specify number of colors directly in 
the text field at right named "Number of col-
ors".  If number of rows is increased, it 
works as [+] button clicked required times, if 
decreased, remove top most selected row 
and following rows.

Change boundary elevations
• Select a row and click elevation field you want change, and enter some value.
• If you want to enter elevations to many rows with regular intervals, enter top and bottom row’s elevations 

in the range of rows, select those rows or all rows in range, click distribute elevations button.
• Elevations should be arranged in descending order.
Change colors
• Click each color box to show color picker panel.
• if you want to change colors gradually row by row, you can use distribute colors button.  Change colors 

top and bottom row’s in range first, then select those rows or all rows in range, click distribute colors but-
ton.  Each RGB color components are arranged in equal intervals between top and bottom rows in select-
ed range.

Sky colors
• All Color Set have Sky colors for using 

Panorama View.  To show sky colors, check 
"Show sky colors" check box.

• If this dialog is called from Panorama dialog 
or type of referred Color Set is Panorama 
type, sky colors are shown initially.

Save new color set or remove color set
• You can create new Color Set with names, they will appear in color set menu.  If this dialog was called 

from Panorama View dialog, type of Color Set will be Panorama type, otherwise Main window type.
• You can remove Color Set showed in color set menu if it is created or imported by user.
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Result
• Click Apply button returns editing result to the dialog who called this dialog.  If it is Map Info panel, Map 

View will be updated.
• Cancel button does not cancel creation or removal of Color Set.
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10.Manage Color Sets
You can manage ( rename, remove, ordering 

in menu, export and import ) color sets.  You 
can import  Color  Set  files exported by other 
user or other Mac.

Manage color sets
Dialog shows color sets other than standard 

three.
Select one color set shows its content in the 

right table.
To rename a color set, double click its name 

in the left table.
Select one and drag it to appropriate position 

to change order in the Color Set menu.
To  remove  color  sets,  select  one  or  more 

color sets and click remove button.

Exporting
You can write several color sets to a file to 

reuse them in other mac or in new system lat-
er, or pass it to your friends.

Select one or more color sets in the above dialog and click export button, and specify place and 
name of saved file.  File extension is always ‘jzcolor’.

Importing
To read Color Set files, click "Import" button and select files in the file dialog.  You can import 

old type color sets with file extension “jzcolr”.
If the same name exists, a dialog appear and you can overwrite or enter new name. Even same 

name exists, if their contents are identical, it is skipped with no message.
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11.Drawing Lakes
You can create lake data to draw lakes if lake region is flat in the DEM 

data.  Lake data are created for each DEM types and be saved as sepa-
rate files.

To create lake data, lake should be larger than 100 DEM data ele-
ments.  If  a lake surface is separated several elevation regions, you 
should make separate lake data for each regions.  Picture at right is 
Lake Baykal using ETOPO2.  It has different elevations for its northern 
and southern part.  It requires you to make two lake data for one lake.

You cannot create lake data for no addressing DEMs.

Create lake data
To create lake data, only one kind of DEMs are allowed in program.  If 

more than one kind of DEMs are read, you cannot create lake data.
Select "Make lake data..." under "Tools" menu after reading DEM files to make lake data for 

them.  "Making lake data" dialog appears and the cursor changes to a water bucket. If you click 
some point on the map, program checks 
around it  whether any lake data can be 
created there or not.  If it can do, click 
point  address  and  elevation  value  are 
shown in  the  panel,  and  lake  region  is 
drawn by lake color.  If not all lake region 
is drawn, click again remaining portion in 
the lake.  After all available lake region is 
drawn, enter lake name and click "Regis-
ter"  button.  You can continue to  create 
next lake data.

To finish creating lake data, click "Exit" 
button in the panel.  Lake data are saved as lake data files.

Edit lake data
You can delete individual lake 

data,  rename  and  change  the 
rectangle  bounding  of  lakes.  
Program  uses  surface  elevation 
and boundary rectangle only to 
determine lake region, therefore 
some places that has same ele-
vation are drawn as lake, even if 
it  is  outside  of  the  lake.   To 
avoid it,  you can create several 
lake data for one lake with ad-
justing rectangles.

Sometimes, lake and aside land 
elevations are equal  in  DEM, in 
such a situation, you may adjust 
rectangle to limit lake area.

Lake name Any name is acceptable.  There is no need of uniqueness but preferable.
Click point Address of mouse clicked point.
Surface elevation Current lake’s surface elevation.
Register Finish one lake data.
Clear Reset lake data creating status and clear fields,
Edit Display lake data table and delete, rename or change lake data .  Refer next 

paragraph.
Exit Finish creating lake data and save them.
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If one of the lakes is selected in the table, its bounding rectangle is shown 
in Map View like a picture at right.  It reflects bounding address changing 
immediately, so that you can adjust bounding rectangle easily.

If you change its name or bounding rectangle, do not forget to click Update 
button.

Lake data files
Lake data are saved as a file for each DEM data types.  Those files are saved 

into a lake data folder specified in the preference dialog.  If you change it, 
SimpleDEMViewer replaces all the lake data by the data in the new folder.

You can copy it from another Mac if it is created by version 4 or newer.

Notes
• In the edit dialog, boundary rectangle of each lake data is shown by latitude and longitude, even if they 

are determined by UTM address for UTM DEMs.  Such a case, latitude and longitude for north-west cor-
ner and south-east corner are shown in the dialog.  It's the same for other-plane DEMs.

• Lake surface is not flat in SRTM DEMs usually, use SRTM DTED instead.
• If you want to flatten lake region, you can use DEM Inspector.
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12.Save and Restore Working Set
There are two situations to save working set.  One is for the automatic restoration at the start-

up.  You can choose restoration occurs always or only when you had saved during previous ses-
sion.  Another is the restoration when you want.  Save working set with name, and restore it later. 
You can save many working sets with names, e.g. one is for world wide map, others for local 
maps, so that you can change maps easily with settings appropriate to DEM files.

Restoration at start-up
Specify this function’s behavior in "Misc." tab of Preferences.  Select one of “Always” or “When 

saved manually”.  If “Always”, working set is always saved before you quit SimpleDEMViewer au-
tomatically.

If not “Always”, select "Save working set…" under "File" menu to show “Save working set” dialog, 
save and quit program. You can continue the job instead of quitting.

Restoration will be activated automatically at next start-up if status was saved. If you want to 
skip restoration, activate SimpleDEMViewer with shift key pressing. In this case, if not “Always” 
restoration is deferred to next time.

Named saving and restoration
To save the working set, select "Save working set…" 

under "File" menu, enter any name to refer later, and 
click save button.

Click  little  triangle  at  the  right  to  show  existing 
names. If you select one of names in list, it will be 
copied to input field. Use it to overwrite or edit it to 
other name. When a name in the list is selected, you 
can remove it.

Saved names are listed in sub-menu of “Load saved 
working set” under the “File” menu.

Before loading saved working set, all DEMs, texture 
maps and user data are removed and panorama view 
settings are reset to defaults.  All  data files are re-
loaded even if same data files are used.

Objects to restore
Save read files and map drawing status, and restore 

them  at  next  time.  Data  and  information  to  be 
restored are followings.
• DEM files
• Texture maps
• User data
• Map position
• Map scale
• Selected rectangle

Followings are saved in named working set.
• Settings in the preference dialog except misc page. In the misc page, only “Base latitude” is saved.
• Contour settings.
• Layer settings of user data.

Notes
Settings in the preference dialog are not restored for start-up restoration, but always remain 

between sessions.
Only file pointers are saved for DEMs and texture files, they are read again at restoration time. 

They should reside in the system, otherwise will be ignored.
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User data are saved as user data files for each memo, route and area.  Even if there are new or 
updated data not saved yet, program quits without alert.  Those data also restored in next time, 
but you’d better to save those data to files before quit to avoid losing data.
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13. Scale Panel
When main window is front most, a scale panel appears.
Scale panel has two states, horizontal and vertical. If it is in horizontal state, the scale varies 

depends on latitude at bottom side of the scale panel, and it shows distance along latitude line. 
Horizontal scale is not available over 85 degree or under -85 degree area.

You can change state by click arc-arrow icon in the scale panel. You can show / hide scale panel 
by  “Show / Hide scale panel” under “View” menu.

Scale unit can be changed among "km" “mile” and "nautical mile" in the preference dialog.
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14. DEM Inspector
Showing cell values of DEM files

DEM inspector panel shows elevation values of 7 by 7 cells around the address started inspector 
there.  The address is shown as “Mark address”.  You can move range of showing cells by arrow 
keys or red arrow buttons on the panel.  White rectangle frame appears on the Map View, its in-
side area represents 7 by 7 cells.  Red cross on the panel and on the Map View represent mark 
address.

Each cell shows one of followings.
• number Elevation value.  Integer or float depends on DEM format.
• sea Sea area. 
• void Void area. 
• (n/a) Out of DEM coverage.

Change elevation values
You can change elevation values of DEM data to flatten sea or lake region, or to amend invalid 

values.  Check "Enable editing" to do it.  Changed values are applied to image of the Map View 
immediately.

Changes are temporary.  They will be lost when quit program or remove DEMs from program.  
Restore function does not maintain them.  If you want to retain them for future use you should 
export DEM as new DEM file.

Edit individual cell values
Click or double click a cell in the dia-

log to change an elevation value.  To fix 
changed value, enter tab or return key, 
or click other cell. 

Elevation  value  should  be  between 
-15000  and  15000  meters.   You  can 
enter “sea” or “void” instead of elevation 
value.
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Set all cells to the same value
You can set all 7 by 7 cells to same elevation value.  To specify the value, double click bottom 

left field, enter some elevation value and click "Set all cells" button.
You can enter "sea" or "void" instead of elevation value.

Set all cells in the rectangle region on Map View
You can select rectangle region on Map View during Inspector 

working, and you can set all cells in it to same elevation value.  
After selecting rectangle region, right click in it to show popup 
menu.  It should show "Place nnn to all cells in frame" menu.  
"nnn" is the value of bottom-left text field of the Inspector pan-
el.

Copy all cell values
Copy all 7 by 7 cell values as string data.  It has tab separator, 

so that you can paste to 7 by 7 cells in the sheet of Number-
s.app.

Notes
• Only base DEM is supported when several kinds of DEMs are read.
• Elevation values are shown as float number in meters even if DEM file elevations are in feet.
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15. Export DEM File
Create new DEM file

Create a new DEM file from read DEMs, whole DEMs or some rectangle portion of DEMs.  You 
can create new large DEM file from many small DEMs, or create smaller DEM from part of large 
DEM.  Also, you can save amended DEMs changed in DEM Inspector.  Output DEM file format is 
BIL or GeoTiff.  GeoTiff can be selected if original DEMs are based on GeoReference, UTM or other 
planes.

Only base DEMs can be used to create new DEM file.  DEMs should be based on WGS84 or no 
address DEMs, that means you cannot save old DEMs from GSI of Japan ( those file extensions are 
one of TEM / SEM / MEM / LEM ).

Output DEM file format depends on source DEM but you can change bit width, that is 16 bits 
integer or 32 bits floating point.

If DEM is based on UTM or other planes, 
you can specify range by XY address like as 
the picture at  right.   If  no address DEM, 
range shows only XY addresses.

Operations
To  show  the  dialog,  select  menu  item 

“Export DEM…” under the “File” menu.
If you have selected rectangle region pre-

viously,  “Selected range”  is  on,  otherwise 
“All  DEM range" is on at beginning.  You 
can change it anytime.

Base DEM Showing base DEM type.
Range
  All DEM range Includes all base DEMs.
  Selected range Includes rectangular region bounded by latitude and longitude or XY addresses. 
Preferred format Set items in the box to source formats.
Type Select bit width of output DEM file.
Sea level Specify elevation value treated as sea, copied to SEALEVEL entry in the HDR file.
Void value Specify elevation value treated as void data, copied to NODATA entry in the HDR file.
North-West / South-East

Shows rectangular region to create DEM file.  180 degree meridian should not be inside.

37



SimpleDEMViewer

File size Shows calculated output file size. If the size exceeds 2 Giga bytes limit, letters will be red. 
Click “Create” button to show save panel, specify name and place there. File extension is “bil” 

always. Bil and HDR files will be created.

Notes
• Output DEM file can’t exceeds 2 giga bytes.
• 180 degree meridian should not be inside.
• Byte order is Intel form ( LSB ) always.
• If selected range address does not match with DEM’s boundary address, they are adjusted automatically.
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16. User Data
You  can  make  memos,  routes  and  areas  on  the 

map. To create user data, start from pop-up menu 
by ctrl+click on the map. You can save them as files, 
read and show them later. You can pass those files 
some other person, so that they can see your memos 
and other user data.  
User data are categorized by "Kind" and "Layer". 10 
Layers are provided, and they are identified by num-
bers 0 to 9. You can create any Kind identified by 
strings. You can control visibility of each user data 
by Layer and Kind combination 
User data cannot be shown and handling on the map 
of no address DEMs.

Memo data
Memos have a mark, title, address and comment. Mark and title are shown on the map. If you 

double click on the memo, its contents will be shown in a separate window. You can configure 
the memo data to display a picture or web page instead of contents dialog. 41 ready-made marks 
are provided, and you can use custom marks up to 50.

Route data
You can create any route connecting place to place. Routes have a line, a title and node com-

ments. You can set line kind ( solid line, dashed line, etc. ), colors and width.

Area data
Area data is bounded by lines connecting points. Area type is one of frame only, translucent, 

hatching, etc.. Title is shown in the center of the area.

You can read ArcInfo exported file (e00 format) as user route data.
You can read GPX format GPS data file to create user memo or route data. 
You can read Placemarks as user data from KML files.
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16.1. Memo Data
About memo data

You can write memos link to an address ( latitude 
and longitude ). A memo consists of title, kind, mark, 
address, contents and elevation. Memos are shown on 
the map as a mark and title. You can make titles max-
imum 3 lines, and can set font and style.

Mark is drawn at the address and title are drawn at 
the right of the mark. If memo has no mark, title is 
drawn as  below-center  of  the  first  line  of  the  title 
points the address.

Memos  have  "kind"  and  "layer"  code.  Visibility  of 
memos on the map can be controlled by kind and lay-
er
Kind You can create new kind with any string
Layer A number, 0 - 9
Mark Select one from prepared set. You can add 

any mark up to 50.
If mark or title string is double-clicked, memo 

content will be shown as next picture.
If url string is placed in the beginning of the 

contents  field  as  picture  below,  pointed  data 
( html document, a picture or a movie file ) will 
be shown instead of above dialog when double-
clicked. To show web page, you should turn it on 
in the Memo preference dialog.

If DEM is no address type, you can't use memo data.
You can format strings in comments field with HTML tags. Refer to section “Formatting contents 

with HTML tags”.
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Create new memo
Place the mouse cursor somewhere in the Map View, and control+click to show context menu, 

and select "Create memo".  You can specify following items in the dialog.

When dialog appear, kind, layer, mark and string-attributes fields are set to those of previous 
one.

Create memos directly from picture files with GPS information
Drop picture files on the Map View to create memos.  If those picture files have exif GPS infor-

mation, memo data are created automatically. Those memos are created as followings.
• Kind and layer are set to those specified in "Memo preferences".  Refer “Defaults of Memos”.
• Title is set to file name without extension.
• Mark and string attributes are set to defaults for the kind.
• Latitude, longitude and elevation are extracted from GPS information of the picture.
• Comment field contains url of the file and creation date from exif information.

GPS address datum should be WGS84 except Tokyo.
<AS note> Pictures should be placed in Memo Library. Even if pictures reside outside of Memo Library, Memo data will be 
created and pictures can be shown until program terminates. Saved such Memo data could not show picture later.


Update memos
You can update each memo, or update common attributes of memos.

Update one memo
there are three ways to call dialog to update each memo.

• Double-click a memo on the map during option key pressed.
• Click "Edit" button on the memo-content-window displayed by double-click memo on the map.
• Select "Edit user data" under “User Data" menu. Select one memo in the list and click "Edit" button.

Update common attributes
Select "Edit user data" under “User Data" menu. Select memos and click "Set all" button. You can 

update following attributes of every selected memos to same values.
• Kind
• Layer
• Mark
• String attributes

Show picture or html page
If url string parsed with '<' and '>' is placed at the beginning of contents field of memo, pointed 

data ( html document, a picture or a movie file ) will be shown when memo is double-clicked.
You have options to select destination to display those pictures or web pages. Options are

• Always in SimpleDEMViewer window.
• Use web browser if those memo points web pages.
• Always use default application of the file to display such memo data. 

"default application" is determined by its file extension.  It may be "safari" or "Preview".

Kind Select from menu, or input any words for new kind.
Layer Select one between 0 and 9 from menu.
Mark Select one from popup table.
Defaults button Set mark, layer and string attributes to defaults for "kind".
Title Any string to be shown on the map in 3 lines. If title exceeds 3 lines, remains will be 

included in the 3rd line.
Address Latitude and longitude at the mouse point is set.  Can be modified to any address.
Elevation Elevation derived from DEM data of the above address is set. Can be modified to any value.

If elevation has no meaning or uncertain, specify -20000.
String attributes Specify font, size, face, color and background for title string.
Comment Any comment strings. If url string parsed with '<' and '>' exist at the beginning, pointed data 

( html documents, pictures or movies ) will be shown when memo is double-clicked.
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In the Memo tab of user data preferences dialog, you can specify this option.
Web site access is not allowed in default for security purpose. To allow it remove check from 

“Don't show web site” in user data preference.

Url forms
"http:" and "file:" forms are available for url string. To point files in the library folder, specify 

only  sub  portion  under  the  library  folder.  Followings  are  examples.  "Photos",  "movies"  and 
"hawaii.rtf" are placed at top level in the library folder.

Url auto collection
Although you can enter url string directly, it is easier that dragging file icon to the memo dia-

log. If the dialog accepts file icon, its url string will be written as above 2 or 3 depending on 
where the file from.

If you drag & drop internet location file, the dialog takes pointed address instead of location file 
itself.

If dropped picture file has GPS information, latitude / longitude / elevation are taken for the di-
alog items. Also picture date ( not the GPS time ) will be placed in memo content.

ex) <file://photo001.jpg> Date(2006.02.02 15:20:30)

Window size
If pointed file is a picture or a movie file, Simple-

DEMViewer get the appropriate window size from the 
file, otherwise you can specify window size with form 
of size= ( width, height ). For example

<http://www.xyz.com/123park.html>  size=(  700, 
600 )

Formatting contents with HTML tags
You can use HTML tags to format strings in con-

tents field. For example, <br>, <b></b>, <i></i>, 
<h1></h1>,  <p></p>  for  each  line  break,  bold, 
italic,  header  and paragraph.  Any  other  HTML tags 
are acceptable but external reference to file or web 
site are ignored, and hyper links could not work.

Memo  contents  display  panel  (  at  right  )  shows 
“HTML view” check box when contents strings include 
HTML tags. Uncheck it to display full text including 
tags.

User Memo Edit Dialog shows full text of contents 
field always as right below picture. No WYSIWYG edit-
ing function available, so you should enter tags man-
ually, or copy from some HTML editor.

If contents field text includes ‘<‘ and ‘>” characters 
even no HTML tags or no external reference as de-
scribed in previous section, some text disappear in 
contents  field  of  display  panel.  In  such  a  case 
uncheck “HTML view” check box.

Pass memos to your friends
If you place memo content files in the memo data library, you can pass memo data with content 

data files to anyone using other Macs. If you place them outside of the library, it is difficult to 

Web page <http://www.abcd.co.jp/pages/123.html>
Local picture file <file:///User/Name/Picture/abc.jpg>
Files in the Memo data library folder <Photos/Fujisan.jpg>

<movies/Cities/tokyo.mov>
<hawaii.rtf>
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pass memo data to other users to see your memo data on other Macs. There is no problem to 
pass memo data to other users if url points internet site or no url string specified.

Move memos
Memo can be moved from original position. You can specify memo address in the update dia-

log, or simply drag memo mark on the Map View.
To drag memo mark, select memo by clicking memo on the map first, then drag memo mark. If 

drag memo title, only the display position of title string will change without updating memo ad-
dress. This display position of title string can not be saved.

In a picture window ( such as Conical projection map ), memo mark can not be moved but title 
string. If you drag title string to outside of the window, it is removed from the window.

Custom marks
Any png pictures can be used as a memo mark.
First, create a folder named "MemoMark" in the "Memo data library folder". Place your png pic-

tures there. Those pictures will be read by SimpleDEMViewer when it starts or library is selected, 
and will be displayed in the mark selection dialog.

Png picture file can have any file name but its file extension should be 'png'. 
Picture size is free, however size of 64 x 64 pixels are recommended, because marks are always 

drawn in the 32 x 32 pixels rectangle.
Maximum number of custom marks is 50.

Defaults of memos
Define kinds and defaults of each kind, also define "Memo data library folder". Do "User Data 

Preferences..." under “User Data” menu. Sequence of kinds in the list affects kind menu of the 
memo creation/update dialog.

You can define defaults includes string attributes and mark for each kind when only one kind is 
selected in the list. These defaults are referred when "defaults" button in the create/update memo 
dialog is clicked or when creating new memo first after program started.

Destination to display pictures and web pages
• Shown in own window.
• Shown by web browser if web site is specified.
• Always shown by default application, such as Safari, Preview, etc.. 

"default application" is determined from file name extension by system.

Data library folder for user memo
Choose a folder to save data to be displayed as memo data content.

Defaults for creating memo data by drag & drop
Select a kind and layer number as default values for new memo data creation by drag & drop a 

picture file.

Memo data library folder
A folder for files referred by memo data content field, and for custom marks. You can specify 

any folder in the memo preferences dialog. Default is no library.
"MemoMark" folder containing custom marks should reside in this folder. Memo content files 

may be placed in this folder without folder structural restrictions.

New Create new kind.
Remove Remove a kind. Kinds used by memos cannot be removed.
Rename Rename current one.
Up Move a kind upward.
Down Move kind downward.
String attributes Set default title string attributes for each kind.
Mark Click mark icon to change default mark for each kind.
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Read KML file as Memo Data
There are many type of data exist in KML ( and KMZ ) file, only simple Placemark with one Point 

is converted to one User Memo Data. Refer to KML Data section.  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16.2. Route Data
About route data

You can plot a route on the Map View.  A route 
has a line, title and node comments. You can spec-
ify line type, color and width. Title and node com-
ments can have 3 lines. Font, size, style and color 
for those strings can be set.

If  line segment length between nodes is longer 
than 150 km, it is drawn as a great circle, other-
wise it is straight line on the screen.

Picture at right shows sample route data on an 
Orthographic projection map using ETOPO5.

Line types are solid line, broken line, chain line, dotted line. Any colors are set to lines. Line 
thickness can be set from menu between 0.5 and 3.0 points.

Routes have "kind" and "layer". Visibility of each route on the map can be controlled by kind and 
layer.
Kind You can create new kind with any string.
Layer A number, 0 - 9.
You can create any kinds, and can delete them. They will be in kind menu.

If DEMs have no address info you can't use route data.
Route data is not restricted to route, but can be used as such rivers, administrative boundaries.

Create new route data
To begin plotting new route, position mouse to an end of the route on the map. Do ctrl+click 

there, and select "Create route" from the context menu. Therefore a red line drawn from start 
point to mouse. Click mouse at the nodes, and double-click at the end node. If you click with op-
tion key, the node may have comment. If you make click on a string, any user data string, the 
string's address will be node address instead of mouse position, and the string itself is set to 
node comment. You can cancel last node by Esc key.

Creation dialog will appear after double-click, enter title, comments, line and string attributes 
as following list. You can modify each node address, and even add or delete nodes in the dialog.
Kind Select from menu, or input any words for new kind.
Layer Select one between 0 and 9 from menu.
Defaults Set layer, line and string attributes to defaults for "kind".
Title Any string to be shown on the map in 3 lines. If title exceeds 3 lines, remains will be 

included in the 3rd line.
Line attributes
-  Color Any colors from color picker dialog. Click color pane to show color picker panel. You 

can specify opacity.
-  Type Select a line type from menu.
-  Thickness Select thickness of the line from menu.
Title attributes String attributes for title on the map. Refer String attributes.
Comment attributes String attributes for node comments on the map. Refer String attributes.
Number of nodes Shows number of nodes in the route, including both ends.
Mileage Total length of routes calculated on the assumption that the earth is ideal sphere with 

radius of 6380 km.
Node selection Select node to display details.
-  top Show start node.
-  prev. commented Show previous node that has comment. If there is no commented node, show start 

node.
-  previous Show previous node.
-  last Show end node.
-  next commented Show next node that has comment. If no commented node exist, show end node.
-  next Show next node.
Node information
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When dialog appears, kind, layer, tile and comment attributes fields are set to those of previous 
one.

Update route data
You can update each route, or update common attributes of route data.

Update one route data
There are two ways to call dialog to update each route data.

• Double-click a route title or comment on the map during option key pressed. If it is done on one of the 
node comments, the node will be shown on the dialog.

• Select "Edit user data" under “User Data" menu. Select one route data in the list and click "Edit" button.
You can drag each node on the map to update its position. To start drag-editing mode, double 

click one of the string on the map during option and shift key are pressed. You can drag little 
black dot shown on each node. To finish drag-editing mode, click any point on the map other 
than those dots. Without entering drag editing mode, you can drag any node with option button 
pressing directly.

Update common attributes
Select "Edit user data" under “User Data" menu. Select routes and click "Set all" button. You can 

update following attributes of every selected routes.
• Kind
• Layer
• Line attributes
• Title attributes
• Comment attributes

Defaults for route data
Define kinds and defaults for each kind. Do “User Data Preferences…” under “User Data” menu. 

Sequence of kinds in the list affects kind menu sequence of the route creation or update dialog.

You can define defaults for each kind when only one kind is selected in the list. These defaults 
are referred when "defaults" button in the create/update route data dialog is clicked.

Read e00 files as user route data
e00 file contains Arc/Info interchange form data. SimpleDEMViewer reads e00 file and extract 

line data as user route data.

-  ( comment ) Any string to be shown on the map in 3 lines. If comment exceeds 3 lines, remains 
will be included in the 3rd line.

-  Latitude & Longitude Showing node address of each node. Value can be modified.
-  Elevation Elevation derived from DEM data of the above address is set. Can be modified to any 

value.
If elevation has no meaning or uncertain, specify -19999 or less.

Add node after this node Create new node between current node and next node. New node will be shown.
Delete this node Delete current node. Previous node will be shown.
Cancel Cancel creation of this route data.
Create Create this route data. Show it on the map.

New Create new kind.
Remove Remove a kind. Kinds used by memos cannot be removed.
Rename Rename current one.
Up Move a kind upward.
Down Move a kind downward.
Attributes Following attributes are set as defaults for each kind.
- Title attributes
- Comment attributes
- Line color
- Line width
- Type of line
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To read e00 file, do "Open" under "File" menu.  
The file name will be "Kind" name of the user rout data. Data names have letters "Arc" follows by 
sequence number.All line and string attributes are fixed values, although you can change any at-
tributes after reading with user data editing functions.
• Ignore all e00 file if it has no ARC data.
• Even if file contains area data, only boundaries are treated as routes.
• Datum should be WGS84.

Read KML file as Route Data
There are many type of data exist in KML ( and KMZ ) file, simple Placemarks with “LineString” 

will be converted to User Route Data. Refer to KML Data section.
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16.3. Area Data
About area data

Area data is a surface of the earth, bounded by points 
with  addresses.   Each  area  data  has  pattern  and  title 
showed on the map.  The pattern is one of frame only, 
translucent, hatching ( vertical, horizontal, right up, right 
down lines ).  Any color can be used for those patterns.  
Title string has maximum 3 lines, and font, size, style and 
colors are specifiable.

Area data have "kind" and "layer" code.  Visibility of each 
area data on the map can be controlled by kind and layer.  
kind : You can create new kind with any string.  
Layer : A number between 0 and 9.  
Several kinds are prepared as defaults, but you can create any kinds, and can remove prepared 
ones.

If DEMs have no address info you can't use area data.
Area data with holes are supported only when creating from external files such as KML.  Can not 

create new Area data with holes by this program, and can not edit holes edge position. 

Create new area data
To begin plotting new area, position mouse to an edge of the area on the map.  Do ctrl+click 

there, and select "Create area" from the context menu.  Therefore a red line drawn from start 
point to mouse.  Click mouse at the nodes, and double-click at the end node.  If you click on any 
user data string, the string's address will be node address instead of mouse position. You can 
cancel last node by Esc key.

Creation dialog will appear after double-click, enter title, line and string attributes as following 
list.

When dialog appears, kind, layer, area type, color and title attributes fields are set to those of 
previous one.  
Addresses show far sides of area data.

Update area data
You can update each area, or update common attributes of area data.

Update one area data
There are two ways to call dialog to update each area data.

• Double-click an area tile on the map during option key pressed.
• Select "Edit user data" under “User Data" menu.  Select one area data in the list and click "Edit" button.

You can drag each edge node on the map to update its position.  To start drag-editing mode, 
double click title string on the map during option and shift key are pressed.  You can drag little 
black dot shown on each node.  To finish drag-editing mode, click any point on the map other 
than those dots.  Without entering drag editing mode, you can drag any node with option button 
pressing directly.

Kind Select from menu, or input any words for new kind.
Layer Select one between 0 and 9 from menu.
Defaults Set layer, line and string attributes to defaults for "kind".
Title Any string to be shown on the map in 3 lines. If title exceeds 3 lines, remains will be included in 

the 3rd line.
Pattern Select an area pattern from menu.

Frame only, Translucent, Dots, Hatchings ( Horizontal, Vertical, right up, right down )
Color Any colors from color picker dialog. Click color pane to show color picker dialog.
Title attributes String attributes for title on the map. Refer String attributes.
Area size Area size calculated on the assumption that the earth is ideal sphere with radius of 6380 km.
Cancel Cancel creation of this area data.
Create Create this area data. Show it on the map.
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Update common attributes
Select "Edit user data" under “User Data" menu.  Select area data and click "Set all" button.  You 

can update following attributes of every selected area data.
• Kind, Layer, Area pattern, Color, Title attributes

Repositioning title string
As a default, area title is drawn at the center of the sur-

rounding rectangle.  Sometimes it is drawn outside of the re-
gion like as picture at right.  You can drag the title string 
anywhere you want, but it depends on the scale.  If scale is 
changed, it is drawn at unacceptable position.

Do the following actions to fix the position to longitude and 
latitude.  Hold down the ⌘ key and drag the title and stop 
dragging at the intended place, and release the ⌘ key after 
the red line indicating movement disappears.  The reference 
position  will  be  changed  to  the  lower  center  of  the  rec-
tangular  area surrounding title  string at  this  time.   If  you 
drag it as shown in the second picture, you can see that the 
reference position has been changed.

When you save the area data, this information also be writ-
ten, so it will be reflected when it is imported later.  Older 
program ignores this information.

Defaults for area data
Define kinds and defaults  for  each kind.   Do “User  Data 

Preferences…” under “User Data” menu.  Sequence of kinds in the list affects kind menu sequence 
of the area creation or update dialog.

You can define defaults for each kind when only one kind is selected in the list.  These defaults 
are referred when "defaults" button in the create/update route data dialog is clicked.

Read KML file as Area Data
There are many type of data exist in KML ( and KMZ ) file, simple Placemarks with Polygon will 

be converted to User Area Data. Refer to KML Data section.

New Create new kind.
Remove Remove a kind. Kinds used by memos cannot be removed.
Rename Rename current one.
Up Move a kind upward.
Down Move a kind downward.
Attributes Following attributes are set as defaults for each kind.
- Title attributes
- Area pattern
- color
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16.4.  GPX Data as User Memo and Route
GPX format GPS data includes waypoint / route / track data.  Reading GPX file to create user 

memo or route data depends on them.  Read the file using ‘Open’ under the File menu.
Addresses always be treated as WGS84.  If elevation data exists, it will be copied as each point 

elevation. Its unit should be meter.
Kind of user data is always “GPX”. If it is not exist already, one created automatically.  If exists, 

all attributes of user data are copied from it.  Layer is set to 0 (zero) always.  If you want to use 
different marks depends on data, you should change individually or change all in edit user data 
dialog.  Save them as user data file if needed.

Memo data
Convert waypoint (WPT) data to memo data.  Kind is always ‘GPX’.  You can change the kind 

anytime after reading to any kind as normal User Memo data.
Waypoint’s name attributes is copied to title field of memo data.  If no name attributes, title will 

be file name plus serial number in the file. <time>, <magvar>, <cmt>, <desc> attributes are 
copied to content field.

Route data
Convert route (RTE) data and track (TRK) data to user route data. Kind is always ‘GPX’.  You can 

change the kind anytime after reading to any kind as normal User Route data.
If track data, each segment is converted to one user route data.
Name attributes is copied to title field of user route data. If no name attributes, title will be file 

name plus serial number in the file.
When ‘rte’, if each point has ‘name’ attribute, it is copied to node comment field. If no ‘name’, 

copy ‘cmt’ or ‘time’ attribute.
When ‘TRK’, if each point has ‘time’ attribute, it is copied to node comment field. If no ‘time’ 

attribute, copy ‘name’ or ‘cmt’ attribute.
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16.5.  KML Data as User Memo / Route / Area Data
There are many type of data exist in KML ( and KMZ ) file, only simple Placemarks are support-

ed, other data are ignored.  Convert “Point” data to User Memo data, “LineString” to User Route 
data, “Polygon” to User Area data.  Refer some style attributes for label, line and polygon, but 
may not all attributes are converted to user data attributes, for example, polygons are treated as 
earth surface area always, extrude option is ignored.

Common items
• User data kind will be set “KMLPlaceMark” always. It will be created automatically if not exist.  If it exists, 

its attributes will be applied.
• Name entry in KML file is set to user data title field.  If one Placemark contains many LineStrings or Poly-

gons, all route or area data has same ‘name’.
• Layer of user data is 0 always.
• If altitudeMode is ‘clampToGround’, elevation value will be ‘none’, even other than ‘clampToGround’, if altitude is 

0 set to ‘none’ also.  For polygons ignore altitude and extrude option.
• Supports KMZ file that has only one KML file.  If cannot read, unzip it previously  and read it.
• You can change any attributes of read data, and save them as user data file for later use.

Memo data
• One point data is converted to one memo data.
• Kind of memo is “KMLPlacemark” and layer is always 0. If kind “KMLPlacemark” exists already, mark and 

title string attributes are taken from it. If the kind is created automatically, mark will be White Flag.
• If label style exists color and size are taken for title attributes.
• Content field of memo data is set to strings of “description”. If ‘description has “CDATA”, its content is set 

to memo content field, so that if it contains HTML structure, its formatting is applied, but hyper link will not 
work.

• Icon style is ignored always.

Rout data
• One lineString data is converted to one route data.
• Kind of route data is “KMLPlacemark”.  If route kind “KMLPlacemark” exists already, title string attributes, 

line-type, line-width, line-color are taken from it.  If Label style and line style are set in KML file, label color, 
label size, line width and line color are taken from it.

Area data
• One polygon data is converted to one area data.
• Kind of area data is “KMLPlacemark”.  If area kind “KMLPlacemark” exists already, title string attributes 

and area-color are taken from it.  If Label style is set in KML file, label color, label size are taken from it. 
Area pattern is “Translucent” if fill option is set in KML file, otherwise it will be “Frame only”.

• Alpha value of polygon color is ignored.
• Extrude option and altitude are ignored always, since user area data clamps to earth surface always.
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16.6. Common Features of User Data
Show / Hide user data

You can control visibility of each user data on the map using kind and layer.  You can set each 
layer's visibility depending on map scale.

To set visibility control, display dialog by "Show/Hide user data" under "User Data" menu.  You 
can set visibility for kinds and layers independently.  Each user data will be shown on the map 
when its visibility is set to "show" for both Kind and Layer.

by Kind
Following object's visibility can be set for each kind of data type.

• Data itself
• Title
• Node comment for route

by Layer
Layer setting is applied to all memo, route and area data. Two type of setting are available. One 

is just show / hide each layer, another is depending on map scale.  Latter is optional.  User data 
are visible when both are set to "show".

Visibility range is set by slider, drag edge of each slider and set it desired scale on the dialog.

String attributes
Specify following attributes in separate dialog.  Defaults for each kind can be set by preferences 

( memo / route / area ) for each user data.

You can use 'Font Panel' to specify font, size. If you use 'Font Panel', 'italic' will be cleared.

　Example of transparency.

Save / Read user data
You can save all memos, routes or areas ( created or read in a session ) or data for selected 

kinds as a file.  Do "Save user data" under "File" menu to save them with any name anywhere. File 
extension are set to "jzmemo", "jzrout" or "jzarea".

Alert dialog will appear when attempt to quit program without saving new or updated user data 
and “Restoration working set” function is not set to “Always”.

To read user data file, do "Open" under "File" menu.  You can double click user data file, or drop 
them on to application icon to read them.  You can read old type data, their extensions are “sd-
memo”, “sdrout” and “sdarea” used by previous version.

Saving user data always creates new file, no update.  You can make new file has same name as 
existing file to replace it.

Edit User Data
You can edit individual data or group of data selected from a table, and also remove a data or 

group of data. You can edit any fields of a data, or common fields of a group.

Font Select a font using Font panel.
Size Specify font size between 5 and 256 points.
Style Specify bold, italic and shadow.attributes.
Letter color Specify any color for letters.
Background transparency Specify whether background is transparent or opaque
Background color Specify color of opaque background. You can specify 

opacity in color picker panel.
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Show data in a table
Select "Edit user data…" under “User Data” menu to display the table filled with user data. Table 

shows kind, layer, name, latitude and longitude.  Data sequence is selectable by any fields.  For 
route and area data, latitude and longitude show center address of the bounding rectangle.  
You can select data group appearing in the table using menus.  
- Show memo, route or area data.  
- Show all kinds or one kind.  
- Show all layers or one layer.

Change all
Select one or plural data and click "Change all" button. You can edit following fields.

Edit individual data
Select one data and click "Edit" Button.  Edit dialog will appear and you can edit any fields. You 

can double-click on the data in the table to invoke editing.

Remove data
Select one or plural data and click "Remove" button to remove them. Alert dialog shows count of 

data to remove.  This operation is just removing them from memory, no affection to the file on a 
disk.

Search data
Enter some string into search field, then those data that have the string in the title field will be 

shown in the table.

Export data
Export User Data currently shown in the table, depending on Data Type,.Kind, Layer and search 

result.  Refer next section.

Find user data on the map
Any user data can be searched by sub-string of title or node comment shown on the map. 

Found user data (mark or node ) are positioned at center of the window.
To search user data, show dialog by "Find..." under "Find&Jump" menu, enter some string to find 

and click "Find" button.  To search next data that has same sub-string, do "Find next" under 
"Find&Jump" menu.

User data its position is out of the DEM data range can be searched, but cannot do search when 
no DEM data is read.

memo kind, layer, mark, name string attributes.
route kind, layer, line attributes, name and comment string attributes.
area kind, layer, pattern attributes, name string attributes.
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16.7. Export / Import User Data to / from Text File
You can export User Memo / Route / Area Data to text files, and import from text files.  Those 

text files make available to use User data by other programs, and vise versa.
Memo Data text file format is TSV ( Tab Separated Variable ), so that you can check and edit 

them in table layout with application “Numbers”.  Other two are normal text files.  TSV is also just 
a text file using tab character as a field separator.

String attributes are not exported nor imported.  When importing, if “Kind” is predefined in the 
User Data Preferences, those predefined attributes are applied.  If you want, you can set string 
attributes by “Change All” function in the Edit User Data dialog.

Export
Press Export button in the User Data Edit Table described in the previous section.  All data 

shown in table are written into one file.  File extensions are fixed to TSV, ROUT, AREA for each 
Memo, Route and Area data respectively.

You have following options in the file saving dialog.
Address form In degrees or in degrees.minutes.seconds.
Number of Decimals for elevation integer, 1 or 2.

Import
Select “Import User Data…” under the User Data menu to read text user data file.  File exten-

sions should be TSV, ROUT or AREA for each Memo, Route and Area data respectively.

Text file format
All files should match followings.
• Text encoding is always UTF-8.
• Ignore lines as comment if first character in the line is semi-colon (;).
• If title or comment in Route and Area.data include spaces, enclosed them with double quota-
tion marks.

• If any string such as title and content has line break characters, change them to \r or \n.

User Memo Data
Write out following items, and read them.

Title Copy except line break character replaced by \n.
Kind Copy.
Layer Integer number, 0 ~ 9.
Mark Number or mark name.  Numbers for standard marks showed in Mark selection panel as tips.  Flags 

are Flag1 ~ Flag5.  User marks are their file names.
Latitude and longitude

Latitude and longitude use each field, if D.M.S form is specified degrees, minutes and seconds use 
each field.

Elevation Integer or decimals in meters.  “(n/a)” is written if data has no elevation value.  -20000 is ac-
ceptable as no value for input.

Content Copy except line break character replaced by \n.

Example.  ( ⇥ is tab character. )
;Title⇥Kind⇥Layer⇥Mark⇥Latitude⇥Longitude⇥Elevation⇥Contents
Tokyo\n東京⇥City⇥0⇥35⇥35.68333333⇥139.75000000⇥(n/a)⇥Capital city of Japan.\nPopulation: 9 millions.
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London⇥City⇥0⇥35⇥51.50000000⇥0.00000000⇥(n/a)⇥Capital of United Kingdom.\nPopulation: 7 millions.
Picture below is screen shot of Numbers.app.

User Route Data
• First line except comment should specify address form.
• Datum is WGS84 always.
• One route data consists of a header line, a node header line, many node lines and a node 
trailer line.  One file contains many routes data.

• The header line should begin with the key word "Route=", and specify route data attributes 
such as title, kind, layer, line attributes. Title and kind are required for every route data. If any 
other item is omitted, it will be the default values.  If Kind is defined already in User Data Pref-
erences, omitted items and string attributes are set to those predefined values.

 < Examples >

; Running courses
AddrForm= D
Route= "Our city marathon", Kind= "Running course", LineColor= red, Width= 1.5
Nodes_Begin
Addr= ( 36.0123456, 139.33333 ), Elev= 456, Comment= "Start"
Addr= ( 36.0123456, 139.33375 ), Elev= 467 )
…
Addr= ( 36.0123444, 139.3340 ), Elev= 499 Comment= "water"
…
Addr= ( 36.0123400, 139.33433 ), Elev= 555, Comment= "Goal"
Nodes_End

Address forms
AddrForm= form
The form is one of followings.
D in degrees ex.) 145.3254028
D.M.S separated by period ex.) 145.25.31.45

Route header line forms
Key words
Route=  Kind=  Layer=  Line=  LineColor=  Width=
First two key words are required. Route= should be the first item and Kind= is the second. Oth-

er items can be specified in any order.
Route= Specify the title of this route, enclosed in double quotes. This will be shown in the map.
Kind= Specify kind, enclosed in double quotes.
Layer= Specify layer number between 0 and 9.
Line= Specify line type with following key words.

normal / dashed / dotandline / dots
Width= Specify line width in points between 0.5 and 30.0.
LineColor= Specify line color on the map by RGBA color components or color name. For RGBA color 

components, specify each red, green, blue, alpha values between 0 and 1.0 enclosed in parentheses. 
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The alpha value 1 is opaque, 0 means transparent. Supported color names are white, black, red, 
green and blue.
ex.) Color= ( 1, 0, 0, 1 )

Color= white 
Node header line forms

Specify "Nodes_Begin" only.

Node line forms
Key words
Addr=  Elev=  Comment=
Addr= is required and should be the first item. Others are optional.

Addr= Specify latitude and longitude in this order putting parentheses around them. If south latitude, or 
west longitude, put minus sign before the value.
ex.) Addr= ( -41.0123, 173.5000 )

Elev= Specify elevation in meter. If elevation is not available or applicable, specify less than or equal to -
19999 meter. If omit this key word, it has no elevation data instead of copy previous data.

Comment= Specify node comment, enclosed in double quotes.
ex.) Comment= "Check point 1"

Node trailer line forms
Specify "Nodes_End" only.

Defaults
If Kind is predefined in the User Data Preferences, Line=, Width= and LineColor= are set to 

those predefined values.
Layer= 0
Line= normal
Width= 1.5
LineColor= red
Elev= No elevation value for the node.

User Area Data
• First line except comment should specify address form.
• Datum is WGS84 always.
• One area data has a header line, a node header line, many node lines and a node trailer line.
• The header line should begin with the key word "Area=", and specify Area data attributes 
such as title, kind, layer and pattern. Title and kind are required for every Area data. If any 
other item is omitted, it will be the default values.  If Kind is defined already in User Data Pref-
erences, omitted items and string attributes are set to those predefined values.

• Node header line has a key word "Nodes_Begin" only.
• Node lines specify each node address.
• Node trailer line has a key word "Nodes_End" only.

 < Sample >

; User Area Data
AddrForm= D
Area= "ABC National Park", Kind= "National park", Pattern= translucent, AreaColor= red
Nodes_Begin
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Addr= ( 36.012456, 139.33333 )
Addr= ( 36.012344, 139.3340 )
Addr= ( 36.012400, 139.33433 )
Addr= ( 36.012302, 139.33421 )
Nodes_End

Address forms
AddrForm= form

The form is one of followings.
D in degrees ex.) 145.3254028
D.M.S separated by period ex.) 145.25.31.45

Area header line forms
Key words
Area=  Kind=  Layer=  Pattern=  AreaColor=
First two key words are required. Area= should be the first item and Kind= is the second. Other 

items can be specified in any order.

Area= Specify the title of this area data enclosed in double quotes. It will be shown in the map.
Kind= Specify kind enclosed in double quotes.
Layer= Specify layer number between 0 and 9.
Pattern= Select pattern by key word below.

frame, translucent, dots, horizontal, vertical, rightUp, rightDown
AreaColor= Specify line color on the map by RGBA color components or color name. For RGBA color 

components, specify each red, green, blue, alpha values between 0 and 1.0 enclosed in parentheses. 
The alpha value 1 is opaque, 0 means transparent. Supported color names are white, black, red, 
green and blue.
ex.) AreaColor= ( 1, 0, 0, 1 )
ex.) AreaColor= green

Node header line forms
Specify Node_Begin only.

Node line forms
Specify one address entry only.

Addr= Specify latitude and longitude in this order putting parentheses around them. If south latitude, or 
west longitude, put minus sign before the value.
ex.) Addr= ( 34.333333, -145.2333333 )

Node trailer line forms
Specify Node_End only.

Defaults
If Kind is predefined in the User Data Preferences, Pattern= and AreaColor= are set to those 

predefined values.
Layer= 0
Pattern= dots
AreaColor= red  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17. Texture Mapping
Any pictures can be used as texture of geo-surface, not only 

for the plane map but also for Bird's-eye views, StereoGraphs, 
Panorama views and any projection maps.  Targets are satellite 
images  such  as  Landsat,  aerial  photographs,  land  use  maps, 
topographic maps and others.  The picture at right uses a Land-
sat image.

To use texture, show a dialog from "Texture maps..." under 
the "Tools" menu.  In this dialog you can
• Read any picture file to use as texture.
• Remove those pictures.
• Define addresses of four corners.
• Set transparency.

If read picture is GeoTiff, created by LSMixer3, world file at-
tached or topographic maps from GSI of Japan, corner addresses 
are set automatically. Those texture are treated as "has native address". World file should be in Lati-
tude and Longitude. 
  (Note : LSMixer3 is included in SimpleDEMViewer 3.9.5 package)

<AS note> Topographic maps from GSI of Japan is treated as normal picture, because program can not 
recognize control file.

Setting Dialog
List of texture
• File names of textures are listed.
• If texture coverage overlapped each other, 

the texture upper in this list is used. 
Names can be dragged to change its order. If 
one of the texture is applied, other texture is 
not applied even if its opacity is less than 100 
%.

• Turn off "Draw" check box to suspend use of 
the texture.

Read
• Click to read a picture file to use as a texture.
Remove
• Remove selected file from texture list.
Show Pict
• Show picture of selected texture in a separate 

window temporarily.
Corner addresses
• If a texture is selected in the texture table, its 

contents are shown here.
• Only north-west and south-east corners can 

be set when the check box "Bounds by Lati-
tude and Longitude" is checked.

• Specify Latitude and Longitude even if the 
picture has UTM addresses.

• You cannot define the texture range that con-
tains south pole or north pole inside.

Parallel to Latitudes and Longitudes
• Check if bounds are parallel to each axes to 

faster drawing.  If the texture has UTM or 
other plane address, cannot check this.

Use region
• Specify texture is full opaque or having transparent portion.
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• Check "Except white" if the texture is topographic map with white background.
• Check "Except black" if the Landsat picture has black boundaries.
Opacity

Specify opacity in percentage. If 100 %, color of the texture is taken to draw. If it is less than 
100 %, mixed with the elevation color.
Fitting on the map
• Show picture on the Map View and place it to appropriate position.
• You can drag whole or each corner, extend or shrink whole picture.

See below for operations.
Reset to data native address
• Ignore any change to the corner addresses and set native addresses if the texture has them.
Change projection plane

If the texture map has address specified by world file or GeoTiff and it is based on UTM or other 
planes, you can change zone number anytime after reading for correction.
Use antialiasing
• Check to use antialiasing for every texture mapping.
Apply texture on the sea and lakes
• Check to apply texture mapping on the sea and lake surface.
Apply shading
• Specify do or not do shading on the textured portion. Sometimes it is better not do shading if the texture 

has shade natively such as Landsat picture or aero-photographs.

Fitting on the Map View
If  you feel  it  difficult  to enter four addresses directly, 

you can show texture on the map temporarily and place it 
correct position by dragging.

When you click "Fitting on the map" button, the dialog 
disappear and texture will be placed at the center of the 
Map View, or at accurate place if  addresses are already 
set.  You can drag whole texture or drag each corner in-
dependently.  You can expand or shrink texture coverage 
by clicking buttons in console panel. 

Though main menu are inactive during this operation, 
you  can  expand,  shrink  or  move  the  map  by  context  
menu, and can drag or scroll it.

You can do following operations from console panel.
Expand / Shrink
• Expand the coverage of texture 1.1 times or shrink it by 1.1.
Transparency ( Slider )
• Set texture's translucent rate during this operation to clear the 

position.
• Transparent portion of the texture is drawn as translucent black.
Cancel
• Cancel the positioning operation.
Done
• Quit positioning operation and use result.

World file
World file for texture map uses all 6 lines unlike one for DEM 

files. Letters a to f in the picture at right represent value of each 
line. The frame in the picture represents top left corner pixel.

Line 1. ( a ) : Horizontal offset to right pixel.
Line 2. ( b ) : Vertical offset to right pixel.
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Line 3. ( c ) : Horizontal offset to below pixel.
Line 4. ( d ) : Vertical offset to below pixel.
Line 5. ( e ) : Horizontal coordinate at the center of the top left pixel.
Line 6. ( f ) : Vertical coordinate at the center of the top left pixel.
‘a’ has plus value always.
‘b’ and ‘c’ have minus value when slope down to right as this picture, plus value when down to 

left. Both are zero when picture is parallel to the axes.
‘d’ has minus value always.
All six values are in degrees or seconds if Geo addressing, otherwise in meters.

Sample
A sample at right is a picture of letters with white background and 

red frame.  Specifying white is transparent, and applied it 
to  panorama view.   If  you use texture  maps with  white 
space like this sample or topographic map, use tiff or png 
format, otherwise letters and lines are not clear especially 
with jpeg format.

Notes
• Always specify addresses by Latitude and Longitude even if its 

native address is UTM or other planes.
• Alert will be display and cannot quit the dialog if you have not set addresses for all textures. If you cannot 

set them, remove them, or set temporary addresses using fitting-on-the-map function.
• Datum of GeoTiff is ignored,.always assumed as WGS84.
• Specified information will be saved with file name. When reading a texture file, stored information will be 

shown. If information exists for the name but picture sizes are different, they are treated as different file, 
and old information will be cleared.

• If a texture map has named planeID addressing, saved information may be changed invalidly if you man-
age several named plane IDs and change sequence or add plane IDs.  Such a case, you should select 
plane ID again.
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18. Select Rectangle Region
Any rectangle region on the Map View can be specified for making bird's-eye views, stereo-

graphs, and saving map picture, or set range to search highest or lowest elevations.
• Select "Select rectangle region..." from the context menu on the map, and move mouse cursor to make 

rectangle and click to define it.
• You can drag the frame of selected rectangle on the Map View to adjust it.
• You can specify rectangle region with longitude and latitude. Go "Rectangle region..." under “Tools” menu 

to show setting dialog.
• To clear the selection, show above dialog and click clear button.

Picture at right is dialog for no address DEMs. 
All values are set in meters. 

Four  numbers  outside  of  red  rectangle  show 
range of read DEM(s).
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19. Copy / Paste Latitude and Longitude
You can copy and paste latitude and longitude as a text string during address control is focused 

in "Jump to address" dialog, "Memo" dialog and other dialogs.  You can copy address on the Map 
View at mouse point, use context menu to copy.  You can select copied text format from propri-
etary format and two floating numbers in Preferences.  
Those text addresses are treated as "WGS-84" .

Text format
Proprietary format
• 'LW ' at start, latitude and longitude follow it.
• First character of latitude is 'N' or 'S' for north or south, 'E' or 'W' for longitude.
• Periods separate degrees, minutes and seconds.

ex)
LW N30.15.25.0 E111.10.30.0
LW S23.10.0 W44.50.10

ISO 6709

ex)
+26-110
-45.66666+15.25
-4540+1515
-4540.000+1515.000
+364533.000-1293636.333

Two floating numbers
±dd.dddd ±ddd.ddd

+ sign can be omitted. Latitude first.
ex)
38.33333 141.0123333
+42  142.666666
-65.3333    -23.456666

Two floating numbers and direction characters
Cdd.dddd Cddd.dddd or dd.ddddC ddd.ddddC

C is one of 'N' or 'S' for latitude, 'W' or 'E' for longitude. Any characters between them are ig-
nored.

ex)
N33 E123
33N 123E
S5.11111 W99.5
E133.5678 N23.45678
Latitude 36.3333N Longitude 111.2345E

Two number strings each has tow or three periods
  Parts separated by period are treated as degrees, minutes and seconds from first.
e.g.
33.26.30 137.40.15,    33.26.30.123 137.40.15.789

These are translated to
33 26 30  137 40 15,    33 26 30.123 137 40 15.789

After this translation, they are treated as six numbers as described in next section.

±DD.DDDD±DDD.DDDD degrees

±DDMM.MMM±DDDMM.MMM degrees and minutes

±DDMMSS.SS±DDDMMSS.SS degrees, minutes and seconds

62



SimpleDEMViewer

Various strings that contain some numbers
If it has three numbers, ignore third number and apply one of above.rules.
If it has four or six numbers and various characters, following steps are applied.

• Replace words ‘North’, ‘South’, ‘West’, ‘East’ to a character N, S, W, E respectively.  
Replace characters 北, 南, 西, 東 to a character N, S, W, E respectively.

• Replace all characters other than numbers, +, -. . (period), N, S, W, E, to space ignoring letter 
case.  Control characters are replaced to space also.

• Separate four or six numbers at the center to two groups.  Each group are treated as an ad-
dress of degrees and minutes or degrees, minutes and seconds.

• If there are characters of N, S, W or E, decide which one is latitude or longitude depends on 
their position. If no those characters is found, first group should be latitude.

e.g.
  +23.456789  -123.456789  2345.6 m
  N34°19'06.8" E131°34'05.0"
  34:12:55 West 35:46:12.123 South
  緯度34°19'06.8" 経度131°34'05.0"

  東経135度1分２.567秒　北緯33度21分33.4秒
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20. Show Place on External Map
You can show the place pointed in the Map View on Apple’s “Maps” or “Google map” on safari.  

Internet connection is required.
In the Map View, show context menu at some place and select “Show this place in Maps.app” or 

“Google map”, then the place is shown in them.  Maps or safari is activated automatically if not 
active.

Show by “Maps”
Activates Maps if not activated, and set center to the place, and shows a pin icon there.  Set ap-

propriate scale depends on scale of SimpleDEMViewer.

Show by Google map
Activate safari ( or your default browser ) if not activated, access Google map and set center to 

the place.  Set appropriate scale depends on scale of SimpleDEMViewer.
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21. Measuring Milage

You can measure milage between two place along any route 
on the map. 

To  begin  measuring,  position  mouse  to  start  point  on  the 
map.  Show context menu and select "Measure milage".  Then a 
red line drawn from start point to mouse cursor and show mi-
lage near cursor.

Click mouse button at some points to fix the route, and dou-
ble-click to finish measuring.   If  you click on any user data 
string, the string's address will be used instead of mouse posi-
tion.  You can cancel last node by Esc key.
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22. Find Highest or Lowest Elevation
Find highest or lowest elevation point among the read DEMs. You can select search range from 

"Rectangle region", "Window region", or "Whole data". Result are shown in a small information 
window and a red-round-arrow on the Map View. You can copy address and elevation value as a 
text string from the information window.  
Result elevation is raw value in the DEM file, not interpolated one.

Operation
• Choose "Find highest or lowest…" under "Tools" menu to show dialog.
• Select highest or lowest, select range and click "Find" button.
• Found point showed by red-round arrow on the Map View, and information window displays details.

If the point is out side of the window, map will be redrawn, so that the point sits in the center.
Results

Click “Copy address" in result panel to copy strings to clip board includes the address and the 
elevation.  DMS or DD format depends on setting in Preferences.

Elevation Shows raw value in the DEM in meters.
Address Shows Latitude and Longitude. If there are many same elevation points, address of first 

found point will be set.
If the DEM has no address, will be blank.

DEM file name DEM file name includes the point.
Position in DEM XY coordinate in the DEM file. The upper left corner is ( 0, 0 ).

String example
DMS LW N33.10.15.33 W100.55.11.01 3770 m
DD 25.1234567 -96.8765432 1234 m
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23. Contours
You can draw contour lines on the map in the Map View 

with or without index lines.  You can select interval and 
its  colors.   Contour  lines  are  drawn on the  map once 
when you click the "Draw" button, and disappear when 
map is redrawn or scrolled.

With retina screen, and with specifying double density 
for  drawing Map View,  contour width will  be half,  and 
takes four times longer.

You can draw contour lines on the saved Map View pic-
tures and projection maps.  In those cases, contour set-
tings are the same as for Map View.

Contour on the Map View is drawn as dot by dot always, 
but you can select line mode for saving Map View pic-
tures and projection maps, so that some draw software, 
such as Adobe Illustrator, can treat contours as lines.  In 
this case you can specify line width.  Line mode drawing  
takes time much longer.  Refer “Line mode” section be-
low.

You can save contour settings with name, so that you 
can refer it later.

Settings
Select "Draw contour lines" under the "Tools" menu to 

show the dialog.  In the dialog, you can specify followings 
and draw contour lines.
Contour set Load saved contour settings with name in the 

menu.
[Save] with name. Save settings in the dialog with name.  Its name 

will be listed in the menu.
Remove Remove contour set showed in above menu.  You cannot remove Standard set.
Interval Enter any value directly in meters or feet. Minimum is 1 m or 1 ft.
Draw index lines for each 

Check and select index pitch to draw index lines.
Color set Select color set for normal and index lines.
Normal, Index Color for normal and Index lines.  Click color box to change them individually.
Use different colors for under [ 0 ] m. 

Check if you want to use different colors and inter-
vals for under sea level.  You can specify depth and 
color for each line. Two colors can be used for sea 
depth. 
Not only for under sea levels, you can use this table 
for lower land near sea level.  You can set each ele-
vation up to 1000 meter.

Color 1, Color 2 Colors for sea depth.  Click color box to change 
them.

Depth / Elev. Depth or elevation for each line in meters or feet.  
Unit is the same as one for interval.

Color Color for each line.  Select from Color1, Color2, 
Normal or Index color.

[+] [-] Add or remove a line.
Default button Reset all settings for "Use different colors" to 

default.
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Don’t draw above sea level. 
Check if you do not want contour lines on the 
land.

Don’t draw sea level. 
Check if you want no lines on seashore.  In-
land contour of 0 meter also disappear.

Don’t draw under sea level. 
Check if you do not want contour lines under 
sea level.

Draw button Click to draw contour on the Map View.

Line mode
You can  select  line  mode when saving  Map View 

picture and creating projection maps in each dialog.  
In  line  mode,  you  can  specify  line  width  for  main 
lines,  index lines and sea depth lines each.   Other 
settings are the same as ones to the Map View.  If line 
color is Main or Index for depth lines, Main or Index 
line width will be applied for them.

Following pictures show results of various settings 
and extended using graphic software.  First three pictures are saved as PNG and last one as PDF.  
All line width and color settings are default value.

First one is drawn in dot mode and 72 dpi.  Second one is drawn in dot mode and 144 dpi.

Third one is drawn in line mode and 144 dpi.  Last one is drawn line mode and 144 dpi.  Last 
one is saved as PDF, and extended by PDF Viewer.

Notes
• Draw button does not erase previous drawing, so that if you changed the interval, you should erase previ-

ous contour lines by refreshing Map View. 
• For saving pictures and projection maps, last settings to draw on the Map View will be used.
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24. Coloring According to Slope Degree
Draw map with colors according to slope steepness.  You can 

specify seven steepness grade and colors to them. 
Colors drawn by this function will disappear when the map is 

redrawn.  The result can be saved as picture files if the map is 
saved with window range.  
In the right picture, red part shows steep slope over 30 degrees.

Settings
Select "Slope Degree…" under the "Tools" menu to show the 

dialog. You can specify degrees, colors and which part to draw. 
Click draw button after setting those.

Because slope colors override current map without refresh, you need to refresh the map before 
redrawing slope colors usually.

Notes
• If you want to save map picture with coloring by 

this function, specify it in the Save Map dialog.    
Before showing save map dialog, set this func-
tion’s dialog and check result.

Draw ( check box ) Select band to draw.
Slope degrees Specify lower limit in degrees for each band.
Color Colors for each band. Click on the color pane to change it. Colors can be copied by drag 

& drop.
Limiting elevation Set drawing range by elevation.
Opacity Specify opacity for drawing colors override the map. 100% override completely. You see 

no slope colors on the map when 0%.
Color set Save settings with name and show it in the menu.
Gradation Colors are changed gradually band to band.
Draw Draw slope colors.
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25. Bird’s Eye View
Make an image of the terrain from DEM 

data.  The image is based on a flat plate ig-
noring roundness of the Earth.  If DEM has 
latitude and longitude, aspect ratio is opti-
mized automatically  based on center  lati-
tude of the picture.

Settings
Show dialog by selecting “Bird’s eye view...” under “Tools” menu.

Target area
• There are three options. They are selected rectangle, window 

and whole data.
• If whole data is selected, Minimum rectangle that includes 

whole data is assumed. This rectangle doesn't stretch over 
meridian at 180 degree. If data exist both side of meridian 180 
degree, the rectangle goes around the earth.

• When DEMs without address info are used, window range 
doesn't cover outside of the whole data range.

Face to
• You can specify any direction in azimuth. Enter number values 

directly or use direction dial. Click tick mark or drag arrow 
head. Click N/E/S/W letters to face each.

Shading
• Select shade type as same as shading for the Map View.
• Light direction is one of eight directions. Elevation angle ( an-

gle of incidence ) is always 45 degrees.
• Strength has 8 levels. 1 is most pale.
Angle of depression
• Specify depression angle in degrees between 0 and 90. 0 

means looking horizontally.
Height emphasizing
• Select rate to emphasize elevation from menu. All elevations 

are multiplied by this rate.
Picture scale
• Select shrink or expand rate from menu in percentage.
• Picture size is defined by target area size, azimuth, depres-

sion angle and rate.
• Maximum picture width and height are 65,500 pixels each.
Coloring according to slope degree
• Settings for the Map View are applied.
Use texture mapping
• Check to use texture mapping.  Settings for the Map View are applied.
Insert a color table
• Insert a color table into the picture. Select position and size.

Add strings in the picture
You can add any one line text on the picture. Click on the picture with control key pressed, and 

select context menu “add string”. In a dialog you can enter string and its attributes. 
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26. Stereographs
Stereograph

This function makes a pair of pictures in a window to 
see 3D image. There are three types, parallel, cross-eyed 
and anaglyph.

Parallel and cross-eye
• Two pictures are slightly different perspectives of same area. 

In parallel mode, left eye looks at left picture and right eye at 
right picture. In cross-eye, left eye looks at right picture, and 
right eye at left one.

• Picture can be full colored, but rather small picture size. Some 
skill is required to look as 3D.

Anaglyph
• Red color from picture for right eye, green and blue from picture for 

left eye compose an anaglyph picture.
• It's mandatory to see terrain that elevation colors contain both red 

and green or red and blue.It is better to set all elevation colors to 
white or other bright colors.

• To see anaglyph, prepare a pair of glasses with red glass in left, blue 
or green glass in right.

Settings
Show dialog by selecting “Stereograph...” un-

der  “Tools”  menu,  or  select  "Create  stereo-
graph…".from  the  popup  menu  on  the  map 
View.
Target area
• There are four options. They are "Selected rec-

tangle", "Window", "Whole DEM area" and "Center 
address and size".  If activated from popup menu, 
last one is selected.

• If whole data is selected, Minimum rectangle that 
includes whole data is assumed. This rectangle 
does not lay over meridian at 180 degree.  If data 
exist both side of meridian 180 degree, the rec-
tangle goes around the earth.

• When DEMs without address info are used, win-
dow range does not cover outside of the whole 
data range.

Direction
• You can specify any direction in azimuth field.  Enter number values directly or use direction dial.  Click 

tick mark or drag arrow head.  Click N/E/S/W letters to face each.
Shading
• Select shade type as same as shading for the Map View.
• Light direction is one of eight directions.  Elevation angle is always 45 degrees.
• Strength has 8 levels.  1 is most pale.
Height emphasizing
• Specify values between 1.0 and 20.0. 1.0 is similar to actual image, but it is difficult to recognize terrain 

unless ups and downs are significant.  If too much emphasizing applied to mountainous area, getting diff-
cult to recognize its image.

Scale
• Select scale rate from menu in percentage.  You can not select larger scale that picture width or height 

exceeds 65500 pixels.
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Picture size
• Although default picture size is defined by target 

area size, direction and scale rate, you can set final 
picture size and distance of two pane in pixels for 
parallel and cross. No size option for anaglyph.

• Click triangle aside the string “Picture size” to show 
layout and input fields.

• Enter width and height of final picture size.
• Span is the distance between centers of two panes.
• In layout picture, two black framed rectangles rep-

resent selected range. Yellow rectangle represents 
final picture. Relief maps are drawn in each green 
part.

• Default button reset width, height and span to defaults.
• If layout is hidden, changing type, target range, direction or emphasizing resets to defaults always.
• Maximum picture width and height are 

65,500 pixels each.
Center address
• If Center address and size is selected as 

target, specify width and height for one 
pane and center address.

• If activated by popup menu, clicked address is set as center address.  If 
changed from Window range or others, center address of each target is 
set.

• In this case, target area is drawn as white frame on the Map View.
Make one pane right projection
• Make one of two panes right projection to determine accurate address in 

the picture for processing later.
• Select left or right pane.
• You can select to draw Meridians and Parallels on it.
Coloring according to slope degree
• Settings for the Map View are applied.
Use texture mapping
• Check to use texture mapping.  Settings for the Map View are applied.

Add strings on the picture
• You can add any one line text on the picture.  Click on the picture with control key pressed, and select 

context menu “Add string”.  In a dialog you can enter string and its attributes.
• Added strings have no stereo effect.

Notes
• When viewing parallel stereograph on the screen with the naked eye, it is difficult to see big picture.  Less 

than 300 pixel width for one pane maybe acceptable.  No such limitation for Cross-eye and Anaglyph.
• Anaglyph is composed of red component from right eye picture and green and blue component from left 

eye picture.  Because of that, all white elevation color is preferable.
• Direction arrow on the Map View is shown at center of the target area.  if it 

is out of the Map View, it is drawn at the center of the map View.
• White frame of target area is not rectangle if DEM is geo-referenced and 

direction is not right angle.  Distortion is larger when its position is far from 
base latitude.
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27. SRVC Relief Map
What is SRVC Relief Map

New relief map formed with slope degrees, 
ridge-valley degrees and surface curvature.  It 
is independent from light direction as normal 
shading relief map.  Furthermore, it is easy to 
capture  landscape  image  without  any  tools 
nor skills like as stereographs.

“SRVC” is an acronym of Slope, Ridge, Valley 
and Curvature.
• Land colors are automatic.  Colors of sea and 
void region depend on Preferences setting.

• No lake is recognized.  Draw it as plane land.
• Picture width is adjusted so that horizontal and 
vertical scale are the same at the center of the map.  Therefore, even if you select window range, picture 
width may differ from window width.

• You can draw Meridians and Parallels, User Memo / Route / Area Data, and Contour.  Their drawing condi-
tions are depends on each settings on the Map View. 

Dialog
Show dialog by selecting “Create SRVC Relief Map…” 

under the Tool menu.
Target There are four options. They are selected rec-

tangle, window, whole data and specified picture 
size.  Last one extends around the center of the 
window.
If whole data is selected, Minimum rectangle that 
includes whole data is assumed. This rectangle 
doesn't stretch over meridian at 180 degree. If 
data exist both side of meridian 180 degree, the 
rectangle goes around the earth.
When DEMs without address info are used, 
window range doesn't cover outside of the whole 
data range.

Picture scale Select shrink or expand rate from menu in 
percentage.

Picture size Determined by target type and scale. If target 
type is the last one, you can specify width and 
height freely.  Both should be less than or equal 
to 65500 dots.

Emphasizing slope
Default value is 3, select between 2 and 4 usually.  If you want to draw flat area such as sea bed, 
select bigger value.

Curvature Specify degree of applying surface curvature to the picture.  Larger value enhances contrast of 
ridge and valley.  See sample pictures on next page.

Draw Meridians and Parallels.
Check if you want to draw Meridians and 
Parallels on the picture.  Interval, color and line 
width are the same as those of the Map View.

    Print latitudes and longitudes
Add latitude and longitude values to each line.  
To change font, click [A] button at right.  You can change font, size and color.

Draw User Data Check if you want to draw user data on the projection map. All settings are the same as those of the 
Map View.
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Contour Select one from the menu “Don’t draw”, “Draw as dots”, “Draw as lines”.  If line mode, you can 
set line width.  Line intervals and colors are same as those of the Map View.
If you select line mode and save as PDF, you 
can edit contour with some draw software, such 
as Adobe Illustrator, later.
Line mode takes time much longer, maybe more 
than ten times than dot mode.

[Copy] four corner addresses.
Copy addresses of four corner to scrap.  It consists of four lines, first line contains address of north-
west corner, south-west, north-east, south-east follow it.  Each address format depends on setting in 
Preferences.

[Defaults] Reset to defaults all settings in this dialog.

Add strings in the picture
You can add any one line text on the picture. click on the picture with control key pressed, and select context menu 

“add string”. In the dialog you can enter a string and its attributes.


Sample pictures
Emphasizing slope value is 3
     Curvature value is 1                Curvature value is 3                 Curvature value is 5
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28. Panorama View
What is panorama view

Panorama  view  represents  your  view  from  some 
place on land surface or in the air.  You can create 
360 degrees panorama view as one picture and can 
rotate it.

Parameters are eye point address, elevation, eye di-
rection, elevation angle, view angle, haze effect, col-
ors and others.  Default color set is same as the Map 
View, but can create any independently.

You can use a target instead of eye direction and 
elevation angle.  If user data exist, you can set the 
target to any user data string point.

Memo data strings, route data lines and strings can 
be  drawn  on  the  panorama  picture,  but  no  memo 
mark.  Route is always drawn as normal line, line type 
and width are ignored.

Shading is the same as it of the Map View, no shad-
ow of mountains.  Although you can draw the sun(s) 
at the time at the eye point, it has no relation with 
shading direction.

If using planet or moon DEMs, no drawing of sea 
and sky.
Projection method

Coordinate system in the panorama view is azimuth and elevation angle, so that near view 
(  bottom of  the picture )  is  drawing wider.   If  target  elevation angle is  not  level  (  not  zero 
degree ), automatically adjust horizontal axis so that distortion of the picture will be minimum at 
the elevation angle.

Creation
There are tow ways to start creating panorama view as follows.  Panorama view start drawing 

after you fix dialog settings and click “Draw” button.  A window appears and the panorama will be 
drawn left to right with scrolling if needed.
Start from context menu

At some point on the Map View you want to view from there, show context menu and select 
“Create Panorama View”.  An arrow and pink colored sector will appear toward mouse cursor. 
Move cursor toward target point, angle of the sector changes depends on cursor distance from 
eye point.  Arrow direction is eye direction and angle of the sector will be view angle.  Click 
somewhere to show creation dialog.  If the mouse point is very near the eye point, view angle will 
be 360 degrees and direction will be set to north.

If the target was set previously, direction restricted to it.
If you start on a string or memo mark, its address and elevation are used as eye point, other-

wise mouse point address and its surface elevation will be taken.
Start from Tools menu

Select “Create Panorama View” from the Tools menu, creation dialog appear instantly. All set-
tings are the same as previous session. If it is the first time, window center will be eye point and 
towards north, view angle is set to 60 degrees.
Cancel during drawing

Drawing panorama may take very long time depends on settings, if you want to cancel it, click 
close button of the window.
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Settings

Eye point
Eye  point  consist  of  latitude,  longitude  

and elevation. Elevation can be specified as 
surface elevation and lift  above there,  or 
elevation from sea level.
Eye position Shows the mouse point address or string’s base address when start by context  menu,.otherwise 

address set by previous session remains.  You can change to any address.  If address is changed, 
surface elevation will be changed to that of addressed surface.

Elevation at surface
Shows calculated elevation from the specified address or elevation value of string data when start 
by context  menu.  Elevation value of string data maybe includes lift from surface already.  You 
can enter any value here, but if you change the address it will be replaced with calculated one.
Even if elevation of string data is set originally, it will be changed as address changed.  If address 
return to original, original elevation will be restored.

Above surface / Above sea
“Above surface” means final eye elevation is “Elevation at surface” plus value specified here.  Eye 
elevation is value specified here when “Above sea” is selected. Although you can enter minus value 
here, if eye elevation is lower than surface elevation calculated from DEM, final panorama view 
maybe invalid.

Eye point name User data title string is set here when this dialog started by context menu activated on a string in 
the Map View.  You can change eye point by searching user data string.  Click “Search” button to 
search user data and set its address and elevation.  You can set new name even no user data exist in 
search dialog.  Refer “Name search dialog for eye or target” section.

Direction
Azimuth Eye direction between 0 and 359.9 

degrees.  North is 0 and clockwise.  If 
“Fix on target” is checked, this value is 
set automatically and not editable.

View angle View width in degrees.  Between 0.1 
and 360.  360 degrees means all around 
eye point, and panorama view can 
scroll through. 
View angle limited to 120 degrees if stereograph is set or “Elevation angle” lower than -45 degrees 
or higher than 45 degrees.

Elevation angle Upward or downward angle between 60 and -60 degrees.  If higher than 45 or lower than -45, 
“View angle” limited to 120 degrees. 
If “Fix on target” is checked, this value is set automatically depends on eye elevation.

Target name User data title string is set here when target specified previously by context menu on a string in the 
map.  You can change target by searching user data string.  Click “Search” button to search user 
data and set its address and elevation as target.  “Fix on target” will be checked and “Azimuth” and 
“Elevation angle” are calculated automatically.  You can set new name even no user data exist in 
search dialog.  Refer “Name search dialog for eye or target” section.

Fix on target If target is set, you can check or uncheck here. If checked, “Azimuth” and “Elevation angle” are 
calculated automatically.
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Color setting
Like color set for the Map View, you can change colors, boundary ele-

vations and save settings, in addition you can set sky color.

Color set menu Default is “Same as Map View”.  Same list of color set as color set 
menu in Preferences dialog appears here.

Boundary elevations 
Specify in meters and descending order.

Color box Click to set each color.  You can copy color to another color box by 
dragging.

Sky color Specify color at top and color at horizon.  Between them filled with 
gradation color.  Actual colors depends on eye point elevation and 
haze effect settings.  If haze effect is stronger, every colors any-
where converges toward sky bottom color.

Save with name Create new color set with colors and elevations.  The name will 
appear in color set menu.

Remove Remove a color set created by user shown in menu.
Edit in separate window 

Although you can edit color set here, you can use separate window 
to edit color set.  Refer "Edit Color Set".

Other settings
Max. distance The scene calculated up to this distance. Land 

farther than this distance is drawn as sea. 
If “Fix on target” is checked, “Max distance” 
should be longer than the distance between 
eye point and target plus 5 km.

Min. distance The scene is calculated farther than this 
distance. Land closer than this distance is 
drawn as sea. 0 km is treated as 2 meters.

Picture size ( Width x Height pixels ) 
Width and height each should be less than or equal to 65500 pixels.

Quality Trade off between speed and quality. Usually “Normal” is enough for quality and speed. Use 
“Preview” to check composition if normal drawing takes longer time. Use “Fine” if result is bad 
quality, for small pitch DEMs or steep mountain scene.

Emphasizing Specify value to multiply elevations by, between 1 and 10. Mountains become higher, sea become 
deeper. Eye point elevation also will be multiplied.

Apply air refraction 
Distant mountains looks higher because of light refraction in the air. The default value 0.133 is at 
the sea level of standard atmosphere.  Although the value differ depends on altitude, there is no 
much difference in scene.  There is much difference depends on local weather conditions, especial-
ly local air temperature such as a mirage in extreme case.. 
Specify value between 0 and 0.3. 0 (zero) means no effect.

Shading Light direction applied to everywhere, that means ignore time 
difference among the place. Even if the Sun is drawn, it has no rela-
tion with shading.

 - Shade strength Select between 1 and 5. Larger get deeper. Default is 3.
 - Light from Select one from 8 direction menu. Default is east.
 - Light angle Select elevation angle ( angle of incidence ) by menu between 10, 30, 45, 60 degrees. Default is 

45 degrees.
Use texture mapping 

Check if you want to apply texture mapping if exist. Settings are the 
same as the Map View.

Draw azimuth indexes 
Draw azimuth index markers and azimuth numbers on the panorama 
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view pictures. Numbers represent degrees and minutes.  Pitch and others are automatic. 
They appear just below upper edge, landscape may overwrite them.

Draw user memo data 
Check if you want to draw user memo title string on the scene if exist and visible.  All settings are 
the same as those of the Map View, except.no mark drawn and string drawn vertically. String at-
tributes can be change on a picture.  Refer following sections.

Draw user route data 
Check if you want to draw user route on the scene if exist and is visible.  All settings are the same 
as those of the Map View, except only color is applied from line attributes, no line type, no line 
width  Strings are the same as user memo.

Apply haze effect of distance 
Because of haze effect, distant 
mountains getting dim.

 - Thickness Specify strength of haze effect 
between 0 and 99.9. 0 (zero ) means no effect.  Default value 20 is adjusted in Japanese atmosphere 
conditions.  Smaller value fits to dry air. 
Dimmed color converges to sky ( bottom ) color.

- Minimum distance 
Apply haze effect farther than this distance.  Default is 0 km.

Apply mist effect of lower land 
Dim lower land just as mist or 
cloud cover them.  Lower eleva-
tion gets more density.

- Upper limit elevation 
This effect is applied under this elevation.  Effect is zero for this elevation, and lower elevation get-
ting more dense towards lower limit elevation.

- Lower limit elevation this 
Land lower than this elevation is drawn with sky color at horizon, so that if lower limit is 0 meter 
sea is drawn as horizon color always.  To draw sea and sea shore in pale color, set lower limit to 
minus elevation value.

- Density Specify strength of effect between 0.1 and 99.9. Default value is 90. Dimmed color getting towards 
sky ( bottom ) color as number becomes larger.

Draw Sun Draw the Sun or suns at specified date and time at the eye point. Refer “Draw Sun” section below. 
This option is not available on planet DEMs.
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Draw Sun
You can draw a sun or suns at the time 

you specify  between 1 Jan.  1990 and 31 
Dec. 2099. 
Time zone Menu list up time zones near the 

eye point Greenwich Mean Time 
and your mac’s system time 
zone. It shows the nearest time 
zone but may not exact one.

GMT Time difference between selected time zone 
and Greenwich Mean Time.

Draw the sun at the time 
Set the time you want to draw.

Draw (n) suns … with (t) minutes interval 
Draw n suns before the time and n suns after 
the time. If you specify 5, 11 suns will be 
drawn, but some of them may be behind the 
landscape.

Draw date and time 
Check to draw date and time next to suns on the picture

Color of the sun Click color box to set color of the sun.
This program treat the Earth as a sphere, so that between sun position and landscape has some 

error.  Margin of error is less than one arc minute vertically and less than a few arc minutes hori-
zontally.

Despite actual diameter of sun varies in season it is always drawn as 32 arc minutes in diame-
ter.

Stereograph
Create two panorama view from both side of 

specified eye point, one is for left eye, anoth-
er  is  for  right.   Larger  emphasizing  makes 
distance between left and right eye point longer, then eye point may go underground if specified 
point is in a narrow valley. In such a case add some to elevation or cut near scene by set some 
value to “Minimum distance” other than zero.
Type Select one of parallel, cross or anaglyph.
Emphasizing Select between 1 and 5 from menu.  If distant view you may want to select larger number. Default 

is 2.
Picture at right is parallel stereograph.
Picture size field specify width and height for 

one view.  If parallel or cross eye, picture width 
should be less than 32750.

View angle should be less than or equal to 120 
degrees.

Reset All
Set all values to default except eye point and target. If “Fix on target” is checked, azimuth and 

elevation angle are set to calculated value.

Name search dialog for eye point or target
Dialog will appear as sheet when one of “search” buttons clicked. The table in the dialog shows 

all strings from user data those can be shown on the Map View.
You can select one in the table or you may enter name, address and elevation directly., so that 

even no user data exist, eye point or target is treated as named point.
Table List up user data strings those can draw on the Map View.
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 - type Memo, Route, Area or Node. Node is for node comment of route data, others are title string for 
each user data.

Name Select one from table or enter directly.
Address Select one from table or enter directly.
Elevation Select one from table or enter directly.
Search string Search substring in the “Name” column text. Table shows only the data those have substring typed 

here.

Handling after completion

Scrolling
Supports mouse wheel scrolling, drag scrolling, scroll gesture on track pad,
If view angle is 360 degrees, you can rotate picture horizontally.

Auto scrolling
Panorama view can scroll automatically if picture width is greater than or equal to 3000.
Pressing left or right arrow key start scrolling. More key down makes speed up or down, or 

change scrolling direction. If view is not 360 degrees, scrolling direction will change at both side. 
Space bar stops autoscrolling.

Show place information
If you move the mouse on the picture, azimuth and ele-

vation angle are shown at upper-left corner of the win-
dow.

If you move mouse to any string on the picture, string 
information appear aside it. It shows string itself, address, 
elevation and distance from eye point. Distance unit 
depends on Preferences.

If you move mouse on the landscape with ctrl-key 
or option-key pressing, information of the place ap-
pears near the mouse cursor.

First and last information will disappear in six sec-
onds if mouse doesn’t move. Just click somewhere 
on the picture to clear those information immediate-
ly.

Handling strings
You can move strings by drag them, and remove 

them by dragging them out of the window.
You can change attributes of any string on the pic-

ture.  Show context menu on the string and select 
“Update string...” to do it.  Refer next section “String 
dialog”.

You can add a new string anywhere on the picture . 
Select “Add string...” from context menu. It has ad-
dress if added on landscape, no address on the sky.

String dialog
(Text field) Original string is set.  You can change to 

any string.
Apply following attributes to all strings 

Check to apply attributes to all string on 
the picture.

Vertical String is written vertically if checked, 
otherwise horizontally.
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Leader line Draw straight line to string from its base point.
 - Line width Specify line width between 0.1 and 3.0.
 - Line color Click color box to set any color.
Font Showing font name. Click “Font panel” button to change.
Size Showing font size. Enter directly or use font panel to change.
Font panel Click to show font panel.
String color Click color box to set any color.
Opaque background Back ground of the string has opaque if checked.
Back ground color Click color box to set any color.
Style Specify bold or not and italic or not.

You can use 'Font Panel' to specify font, size, style, Letter color. If you use 'Font Panel', 'italic' 
will be cleared.

Set eye or target point from picture
Set new target or eye point from context menu.

Set to Target Set the place where context menu start to target.
Set to Eye Point Set the place where context menu start to eye point and show Panorama View creation dialog.
Set to Eye Point and Look back 

Set the place where context menu start to eye point, current eye point to target and show Panora-
ma View creation dialog.

Reposition map from a point of picture
Reposition the Map View as its center is some place of 

the picture.  Show context menu at anywhere on the land-
scape, select “Show Place in the Map View”.

Show info
Select “Show info” under the File menu to show setting 

information. A sheet panel will appear and shows all set-
tings of creation dialogs except colors and sun.

Click “Show creation dialog” button to show dialog having same settings with current view, col-
ors and sun settings also set as same.

Click “Export settings” button to save all settings. Refer next section.

Export and import settings
Saving all settings of some panorama view to a file, to refer later or to pass other users. Click 

“Export settings” button in the info panel of a panorama view window to save settings to a file. 
Saved settings includes colors and sun settings. The file extension is ‘sdpano’.

Use ‘Open’ under the File menu to read this settings file. After the file is read, creation dialog 
will be shown. Required DEMs should be read previously, as exported file has no DEM file infor-
mation. You can double click a setting file, or drop it on to application icon or main window to 
show panorama dialog.

Notes
• No DEM area is drawn as sea except using planet DEM.
• To check visibility of string, program uses elevation belong to it. If it is lower than calculated elevation from 

DEMs, uses calculated one. If the string has no elevation, calculated one is used.
• When result picture is saved as jpeg or tiff file, GPS information will be attached. They are Eye point ad-

dress, elevation and azimuth.
• Antialiasing is applied to the sky lines automatically except preview mode.
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29. 3D Movie
About 3D Movie

You can rotate landscape, or go through landscape at real time or faster speed. There are fol-
lowing three modes. You can control speed and direction by keyboard.
• Rotation mode. Rotate landscape around a point.
• Flight mode. Flight as a plane in landscape.
• Boat mode. Cruise by boat on the sea or a lake.

The movie window may not show landscape normally depending on your Mac. If your Mac’s 
power is not enough to treat large data, try smaller data.

Functions

Common
• Start OpenGL view using selected data range.
• Treat all data as they are on a flat plate.
• You can set window size at start and can change it anytime during playing.
• Support full screen mode. You can change anytime during playing.
• You can set view angle at start and can change it later during playing.
• Maximum viewable distance is determined by DEM data pitch automatically.
• Can display eye altitude in a movie window. ( Mac OS X 10.10 or newer. )
• Can display speed in a movie window except rotation mode. ( Mac OS X 10.10 or newer. )
• Colors are same as elevation colors of Map View, although shading can be specified independently.
• You can select meters or feet for altitude unit.
• You can select speed unit from kph (kilometer per hour), mph (miles per hour) and knots (nautical miles 

per hour).

Rotation mode
• Automatically rotating 3D landscape around a specified 

point.
• Before start you can set eye altitude and distance from 

center point.
• During playing, you can change direction and speed of 

rotation, can change eye altitude also.
•

Flight mode
• You can go through landscape like as flying by a plane. 

Even though simulate some of planes behavior include 
bank, this is not a flight simulator, no gravity, no aero dy-
namics and no cockpit equipment.

• You can start flight with specifying place, altitude, speed 
and direction.

• You can go upward, downward, turn left, turn right, get 
slower or faster speed during playing.

• You can set start place and direction on the Map View 
using context menu.

• Without changing going direction, you can see left front, 
right front  or under front with angle of 45 degrees diago-
nally.

• Can apply fog or mist effect.
• Show current place on the Map View.
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Boat mode
Differences from flight mode are follows.

• Altitude is fixed to start up setting.
• No bank during turn.
• Eye elevation can be specified between 0 and 20 degrees, and can change it during playing.
• No under front view.

Activate boat mode on the flat surface, sea or lake.

Dialog
To display start up dialog, select “Start 3D movie…” under the Tools menu. If you start using 

context menu on the Map View, the dialog shows flight mode or boat mode, although you can 
select rotation mode.

All elevations and altitudes are based on sea level.
Common
Target Select DEM data range in it you can flight, 

cruise or rotate it.  There are three options.  
They are selected rectangle, window and 
whole data range.

Data size Showing data size for selected range.  When  
several type of DEMs are loaded, shortest 
data pitch is used for whole region.  If the 
usage ratio to the maximum buffer size sup-
ported by the GPU is large, the letters will be 
displayed colored with orange or red. When 
data size is too big, the "Run" button will be 
turned off. Even if the letters are black, it may 
be very slow or not draw correctly depending 
on the performance of the GPU. In such a 
case, please reduce the amount of data.

Window size Set window size at the beginning.  You can 
change to any size during playing. Minimum 
is 400 by 300. Should not exceeds screen size.

Shade strength Select one between 1 and 5, bigger will be 
darker.

Light from: Select light direction for shading.
View angle View width in degrees.  Between 10 and 120. You can change it during playing.
Elevation unit Select unit of elevation and altitude from meter or feet.  Selection is applied in the dialog and 3D 

movie view.
frames / sec. Select number of frames to draw per seconds between 10 and 60.  Default is 30.  If data size is 

large, the movie may not draw correct images for specified frame per seconds.  On the less power 
Mac, smaller number of frames is better to draw images, but may not be smooth movie.
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Mode selection Select on of mode from menu. If this dialog is called from context menu on the Map View, flight 
mode or boat mode is selected, yet you can change to rotation mode.

Rotation mode
Target elevation Specify elevation value of rotation center. Surface elevation is set at first.
Surface elevation at center

Surface elevation of the center position of the selected range is set.
Eye position Determined by distance from the center and altitude. Start at south of the center point.
Distance from the center

Specify distance in meters. It is fixed during playing.
Starting altitude Specify altitude in meters or feet. You can change it during playing.
Flight mode
Starting position Latitude and longitude of the start point. If 

DEM has no address, XY address in meters 
are shown. If you activate this function from 
the Tool menu first, the start position is bot-
tom center of the selected target area.

Altitude Starting altitude, should over surface ele-
vation.

Surface Surface elevation of the starting point is set.
Direction Set starting direction in as an azimuth in 

degrees clockwise from the north.
Speed Set starting speed in kph ( kilometer per hour ), mph ( miles per hour ) 

or knots ( nautical miles per hour ).
Apply fog effect Specify if you want to apply fog effect. Linear fog model of OpenGL is 

taken, it is different from panorama view function.
Reset Reset settings to defaults. Starting position, view angle, direction, speed 

and fog effect are affected.
Boat mode
Position at start Same as flight mode.
Altitude Same as flight mode but fixed during playing.
Surface Same as flight mode.
Direction Same as flight mode.
Speed Same as flight mode.
Elevation angle Upward angle between 0 and 20 degrees for 

looking up.
Apply fog effect Same as flight mode.
Reset Reset settings to defaults. Starting position, 

view angle, direction, speed, elevation angle  and fog effect are affected.

Run time operations
Common
• Window size can be changed as usual windows.
• Click zoom button to go full screen mode, or click full screen icon at the upper right of window on older 

system. 'esc' key return to normal window.
• '[' key extend view angle ( to show wider scene ), ']' key narrows view angle. Click once extend or narrow-

er 10 percent. 10 degrees minimum and 120 degrees maximum.
• 'A' key shows or hides altitude, speed and other information on the information bar at the bottom of the 

window.  On some older Macs, those cannot upgrade to Mojave, such information are shown in the 
movie.

• Space key pauses or restarts the movie.
Rotation mode
• Right and left arrow keys change rounding speed and direction. '/' key stops rounding.
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• Up and down arrow key change eye altitude.  Minimum altitude is 100 meters, maximum is 10 times of 
distance from the center.

• During paused by space key or stoped by ‘/‘ key, mouse wheel rotates the landscape,
Flight mode
• Right arrow key turns right, Left arrow key turns left.
• Up arrow key nose up, Down arrow key nose down.
• '.' (period) key gets slower speed, '.' (comma) key gets faster speed.
• '/' key returns to straight and level flight.
• ‘/‘ with control key returns to straight flight.
• 'c' key shows or hides white cross that points moving direction.
• 's' key shows left front scene, 'd' key shows right front scene, 'x' key shows down front scene. 'e' key re-

turns to front scene.
Boat mode
• Right arrow key turns right, Left arrow key turns left.
• Up and down arrow keys ups or downs eye direction.
• '.' (period) key gets slower speed, '.' (comma) key gets faster speed.
• '/' key returns straight.
• 'c' key shows or hides white cross that points moving direction.
• 's' key shows left front scene, 'd' key shows right front scene, 'e' key returns to front scene.

Save as movie file
You can make a movie file with capturing 3D movie window using QuickTimePlayer.

• First activate 3D movie, stop playing by pressing space bar at appropriate scene.
• Set up QuickTimePlayer’s screen recording function, and start recording.
• Restart 3D movie by pressing space bar.
• You can use system’s screen recording function also.

Notes
• To quit SimpleDEMViewer, you should close 3D movie window first.
• If your Mac’s fan rotates faster and noisy, play with smaller data size, or pause the 3D movie by pressing 

space bar temporarily until Mac will be cooled.
• In the 3D movie, landscape is projected to a plane, differ from Panorama view that project it on a cylinder 

or corn, then projected landscapes are differ each other.
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30. Visible Region
What is Visible Region

The places from where can see some point, or can 
be seen from some point  This “some point” called 
“Target” is any point on the land or any object such 
as mountain peaks or buildings

Result color is drawn on the Map View.
To check the visibility, the eye point is set to one 

meter high from the surface and looks to target.

Show dialog
Select “Visible region...” under the “Tools” menu to 

show dialog, or select “Draw visible region...” from 
the context menu on the Map View.  Latter case, the 
place where show context menu is set to the target.

Settings
Target Name is shown if it has name.
- -(Address) Shows the mouse point address or string’s base address when start by context  menu,.otherwise 

address set by previous session remains.You can change to any address.
 - Elevation Shows calculated elevation from the specified address, or elevation value of string data when start 

by context menu.
 - Search button Click this button to show search name dialog. Select a name in the table shows user data titles and 

node comments. Search name dialog is the same as it of Panorama View.
Range Select window or selected rectangle to draw.
Quality Select “Faster” or “Fine”. Usually “Faster” is appropriate for speed and quality. If DEM data pitch 

is short ( maybe less than 1 second ) and focused place is affected by steep mountains, use Fine.
Draw on sea Check to draw on sea also, otherwise no drawing on sea.
Color for visible region 

Click color box to change color to draw. If opacity is less than 100 %, actual color is different.
Transparent / Opaque 

Specify opacity in percentage.
Air refraction factor 

Same as in Panorama View . Use default value 0.133 usually.

Notes
• To clear this drawing do “Redraw map” under “View” menu.
• If you do this function twice with translucent color for two different target, places from where you can see 

both target is drawn thickly.
• To save result as picture file, specify window range, same scale and dpi as the Map View in saving dialog.
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31. Geo-Profiles
You can make profile along user route data. You can configure its appearance after creating it.  

If user route data has node names, profile shows them with names, elevations, mileages from the 
start node.

Creation
You should provide user route data before creating profile. Select "GeoProfile image" in the 

"Tools" menu. Select one route data to make profile along it, and click "Make" button. Profile pic-
ture window appears with default settings. You can configure appearance in settings panel.  
You should read all DEMs under the route before creating the profile.

Settings

Always two level lines are drawn above the highest elevation.
Set higher elevation for upper limit when names are intersect profile.
You can reflects new elevation color settings by clicking "Apply" button after changing elevation 

colors in preference dialog.

Save as
You can save the profile as a picture file. Saved pic-

ture depends on current configurations. Whole pic-
ture is saved ignoring current window size.

Notes
• Data interval of profile is same as DEM data north-south 

interval. E.g. 10 meters for 10 meter DEM, about 93 me-
ters for 3 sec. mesh DEMs. If the map is extended in the 
Map View, data interval is shorten in same rate of map 
scale.

• If a distance between route nodes is long enough, in-
termediate points are calculated as they are on the great 
circle.

• Elevations in the route data are ignored. Always use ele-
vations calculated from DEMs.

Height range Specify upper and lower limit in elevation. This determines picture height.
Level lines interval Select from 10/20/50/100/200/500/1000/2000/5000m/Auto.
Height emphasizing Select from 1/1.5/2/3/4/5/10/20 times.
Profile color Select one of white ( only profile line ), Gray ( top is dark, lighter to bottom ), 

Elevation colors.
Elevation colors and gradation depend on preference settings if you select elevation 
colors.

Draw
- levels
- names
- elevations
- mileages 

Set show or no show for each items.
Level lines and their height.
Node names for named node of user route data.
Elevations for each named node.
Distance from start point.
Select one of named nodes or pitch.

Set base to right edge Position start point of route to right edge in profile picture. ( flip horizontally )
Title Any title string to show at top center position in the picture. Default is route data title.
Apply Redraw profile picture.

Scale menu Select from Auto/200/100/50/20/10/5%. If auto is selected, scale depends on window 
width.

Shrink button Set smaller scale in the above scale menu.
Enlarge button Set larger scale in the above scale menu.
Panel Show or hide configuration panel.
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32. Grayscale Maps
You can create  8  bits  or  16 

bits  grayscale  map.  It  may be 
imported to some 3D rendering 
software.

Grayscale  direction,  high-
white  or  low-white,  is  selec-
table. You can choose shading 
also.

Dialog
Select "Create Grayscale Map..." under the "Tools" menu to 

display  the  dialog.  You  can  specify  followings  and  click 
"Make" button to make grayscale map.
Target Select data range to create grayscale map. One of 

selected rectangle region, window or whole data.
Picture scale Select picture size as percentage to the original data.
Picture size Width and height should be less than 65,500 dots.
Bits per pixel Select 8 bits or 16 bits.  Select 16 bits if you want the 

result to use in 3D rendering software.
Range of grayscale 

Map elevations to grayscale 0 to 255 or 65535.
 - Use max. and min. of data 

Highest and lowest elevations of DEM are used.
 - Use max. of data, 0 m for min. 

Highest elevation value of DEM and 0 meter are used. 
If lowest elevation is below 0 meter, it is used.

 - Use below Use specified elevations to both limits. If highest or 
lowest elevation of DEMs is out of limits, it is used.

Direction Select high-white or low-white.
Add ... m ... Add specified number of meters to the elevations other 

than sea area to clear seashore in 3D software. Do not 
use this function if DEM has no sea info, such as 
ETOPO and SRTM.

Do shading Check to apply shading.
 - Light from Select one of eight direction.
 - Strength Select one between 1 and 5.
[Copy] four corner addresses

Copy addresses of four corner to scrap.  It consists of 
four lines, first line contains address of north-west cor-
ner, south-west, north-east, south-east follow it.  Each address format depends on setting in Prefer-
ences.
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Add strings in the picture
You can add any one line text on the picture. click on the picture with control key pressed, and select con-
text menu “add string”. In a dialog you can enter string and its attributes. 

Save as picture file
You can save grayscale map as a picture file as same as other pictures.  You can select any pic-

ture format for 8 bits grayscale, but only tiff or png format for 16 bits.

Notes
• With shading, white lines may appear along seashore. To remove them, specify 10 meters or so in 

"Add ... m ..." field.
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33. Projection Maps
About projection maps

Supports creating Orthographic, Conical, Mercator, Azimuthal Equidistant, Azimuthal Equi-area, 
Universal Transverse Mercator and Lambert Conformal Conic projection maps.  Those maps are 
drawn in separate windows and can be saved as picture files in various format.

You can set center address of the map and size of the picture.  Map scale will be the same scale 
of the Map View.  Also elevation colors and shading parameters will be the same those of the Map 
View.

You can set projection center apart from map center except Mercator and UTM projection maps.  
In this case, equidistant circles will be drawn around the projection center.  There is a sample 
picture at the last of this section.

To display the creation dialog, select "Create projection map" under the "Tools" menu or from 
the context menu on the Map View.  If context menu used, mouse point address is set to center 
address field, otherwise center address of the window is set.

To create projection maps require geo referenced DEMs, UTM DEMs or managed plane DEMs.  
No UTM projection map with celestial DEMs.

Settings
Type menu Select projection method.
Center address Set center address of the map.  Initially it is 

set to center address of the Map View if called 
from Tools menu.  It is mouse point address if 
called from context menu.
Latitude should be between 80 degree north 
and 80 degree south for Mercator, Conical 
and UTM projection maps, for Lambert con-
formal conic projection maps it should be be-
tween 80 and 20 north or between 20 and 80 
south.  This limitation is not applied if sepa-
rate projection center specified.

Use separate projection center
Projection center address

You can set projection center to any address, 
but it should be inside the picture and latitude 
should be inside above limitation.
You cannot use separate projection center for 
Mercator and UTM projection maps.
If this address is specified, equidistant circles 
will be drawn around it, and scale at the point  
is the same scale of the Map View instead of 
picture center.

Picture size Default is the size of the Map View.  Width 
and height should be less than or equal to 
65500 dots each.

Set to main window size
Set picture size to the size of the Map View.

Draw latitude and longitude lines
Check if you want to draw latitude and 
longitude lines on the projection map.  Inter-
val, color and line width are the same as those 
of the Map View.
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Print latitudes and longitudes 
Add latitude and longitude values to each line.  To change font, click [A] button at right.  You can 
change font, size and color.

Draw user data Check if you want to draw user data on the projection map.  All settings are the same as those of 
the Map View.

Contour Select one from the menu “Don’t draw”, “Draw as dots”, “Draw as lines”.  If line mode, you can 
set line width.  Line intervals and colors are same as those of the Map View.
If you select line mode and save as PDF, you can edit contours with some draw software, such as 
Adobe Illustrator, later.
Line mode takes time much longer, maybe more than ten times of dot mode.

Draw Equidistant circles
Check if you want to draw equidistant circles.  This field will appear only for Orthographic, Az-
imuthal Equidistant, Azimuthal Equi-Area projections.

- Interval Specify interval of the equidistant circle in unit of kilo-meter, miles or nautical miles.
- Line color Click color box to change line color.
- Line width Select line width from the menu between 0.5 and 2.0 points.
Insert color table Insert a color table into the picture.  Select position and size.

Lake color will appear when "Draw lakes" is set to on in Pref-
erences.  Sea color is shown always.

 

Orthographic projection map
The orthographic projection is azimuthal parallel 

projection.  If scale is small enough hemisphere of 
the earth is  drawn in  a  circle  like  the picture at 
right.  
You can specify projection center and picture size.  
The scale and latitude and longitude line interval 
are the same as those of the Map View.  
Picture at right is drawn as in the smallest size (5%) 
using ETOPO2.  
To make this map, select "Orthographic projection 
map" under Tools menu Also available from con-
text menu on the Map View.  
Scale of the center is the same as the scale of the 
Map View.
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Conical projection map
The  map is  projected  to  a  cone  that's  apex  is 

North pole or South pole depending on center lati-
tude.   The cone surface  contacts  with  the  globe 
surface  at  center  latitude.   If  center  latitude  is 
equal to the Equator, the map projection method 
turn  to  cylindrical  projection  instead  of  conical 
projection.

Center  latitude  should  be  between  80  degree 
south and 80 degree north.

Picture at right uses ETOPO2, and scale rate is 
8%. Center latitude is 40 degree.

Mercator projection map
You  can  create  Mercator  projection  map 

around the specified center point. Scale on 
the Equator is same as the scale of the Map 
View.  
Picture size you specify in the dialog defines 
drawing range, no affection to scale.  
Picture at right is drawn in the smallest size 
(5%) using ETOPO2.

Azimuthal Equidistant projection map
You can create Azimuthal Equidistant projection 

map around the specified center point. Scale is 
same as the scale of the Map View at the center 
point.

Picture  size  you specify  in  the  dialog defines 
drawing range, no affection to scale.

Picture  at  right  is  drawn in  the  smallest  size 
(5%)  using  ETOPO2,  centered  to  Paris,  France. 
Interval of equidistant circle is 2000 km.
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Azimuthal Equi-area projection map
You can create Azimuthal Equi-area projection 

map around the specified center point.  Scale is 
same as the scale of the Map View at the center 
point.

Picture size you specify in the dialog defines 
drawing range, no affection to scale.

Picture  at  right  is  drawn at  10% scale  using 
ETOPO5, centered to Paris.

Universal Transverse Mercator (UTM) projection map
You can create  Universal  Transverse  Mercator  (UTM) 

projection map around the specified center point. UTM 
zone number is  determined by center address.  If  just 
equal  to  boundary  longitude,  smaller  zone number is 
taken.

Both side of center meridian are drawn up to 6 de-
grees. North and South pole can be drawn, but center 
latitude should be between 80 and -80.

Zone  number  of  the  picture  at  right  is  30,  center 
meridian is 3 degree west.

Lambert Conformal Conic Projection map
You  can  create  Lambert  Conformal 

Conic projection map around the speci-
fied  center  point.   Although  standard 
projection  method  has  two  parallels 
touched surface of the earth, only one 
parallel at the center touch the surface 
here.  Scale is same as the scale of the 
Map View at the center point.

Center latitude should be between 80 
and 20 degrees north,  or  between 20 
and 80 degrees south.

Sample picture below as created using 
ETOPO1 in 20 % scale  centered at  40 
degree north and 100 degree west.
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Strings in the picture
Strings ( of user data ) are draggable and removable.  To remove strings, drag them outside of 

window.
You can add any text on the picture.  Click on the picture with control key pressed, and select 

context menu “add string”.  In a dialog you can enter any string and its attributes.  Strings ( in-
cludes user data ) are editable.  Show context menu on a string and select “Update string” menu.

Save as a picture
You can save projection map as picture files as same as other pictures.  If picture format is jpeg, 

tiff or png, center address is written in the file as GPS information.
If you want to print the picture, save picture as pdf file.  Strings and lines are maintained vector 

information in pdf file.  If contours are drawn as lines, it also maintain vector information.

Sample picture with separate projection center
This is Orthographic projection map centered on Tokyo.  
Distance numbers are added after completion of drawing.
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34. Picture Windows
This section describes handling windows of Bird’s eye view, Stereograph, Grayscale map and 

projection maps.  For main window, Panorama view and Geo-profile refer each section.

Compact view
When the picture size is very large, you can shrink it to view whole picture. 

You can select one of 50%, 33.3%, 25%, 20%, 10%, 5%, 2% and 1% as small 
enough to see. If picture height becomes less than 600 pixels, no more shrink-
ing available.
⌘+[ get smaller, ⌘+] get bigger. ⌘+0(zero) to original size ( 100% ).
As shown in picture at right, if cursor position is at top left corner of the pic-

ture window, a slider and buttons will appear. you can change percentage by 
them.

During being shrank, editing and moving string are not available.
Latitude and longitude lines, equidistant circles and user data are not drawn if 

picture is shrank smaller than 20%.

Show picture info
You can show information of pictures, such as size, address and some of creating settings. Af-

ter selecting a picture window, do “Show info” under the File menu.
These are some samples.

Save picture
Do "Save" under "File" menu when target picture window is in front.  Whole picture saved as 

100% size anyway it is shrank.
You can select picture file format and options.  For 16 bits grayscale map, only tiff and png are 

available.  If you want to print the picture, select pdf file so that strings and lines are printed 
finely.

Refer next section also.

96



SimpleDEMViewer

35. Save Pictures
You can save pictures of map image or pictures of other picture window images.  Any picture 

file format is available as long as QuickTime supports.  You can select pdf also.
If you want to save pictures to print, select pdf format especially when pictures include strings 

and lines.

Saving map view picture
Do  "Save"  under  file  menu  when 

main  window  is  most  front  except 
scale panel.  A sheet dialog prompts 
you  to  select  target  area  and  scale.  
After  clicking  save  button,  you  can 
specify  file  name and format  in  the 
file navigation dialog.
Range Select range for creating 

picture.  If you select 
“Size by pixel” specify 
width and height.  In this 
case, picture center is set 
to the center of the Map 
View.

Scale Specify percentage to the DEM data.  Initially, it is set to the same percentage of the Map View.
Picture size Specify width and height of the picture if range is “Size by pixel”, otherwise set automatically.  

These values are in points, actual pixels is twice when 144 dpi is selected.  MB or GB value is size 
in the program, actual picture file size in the disk storage is vary depends on file format.

Resolution Select 72 or 144 dot per inch.  When 144 dpi is selected, String size and line width are extended 
twice to maintain balance with landscape as same as the Map View.

Draw user data Check to draw User Memo / Route / Area data.
Contour Select one from the menu “Don’t draw”, “Draw as dots”, “Draw as lines”.  If line mode, you can 

set line width.  Line intervals and colors are same as those of the Map View.
If you select line mode and save as PDF, you can edit contour using some draw software, such as 
Adobe Illustrator, later.
Line mode takes time much longer, maybe more 
than ten times than dot mode.

Coloring according to slope degree 
Settings previously used to draw in the Map View 
will be taken.

Create world file Specify to create a world file.  See below.
Print latitudes and longitudes

Check to add latitude and longitude value strings.  
No minus sign is added to west longitude and south 
latitude.  No print if seconds part of the address is 
not zero.
To change font, click [A] button at right. font panel 
will appear and you can change font, size and color.

Insert color table Insert a color table into the picture.  Select position from four corners and 
select size.  Lake color will appear when "Draw lakes" is set to on in Prefer-
ences.  Sea color is shown always.

[Copy] four corner addresses
Copy addresses of four corner to scrap.  It consists of four lines, first line 
contains address of north-west corner, south-west, north-east, south-east follow 
it.  Each address format depends on setting in Preferences.
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Saving other window pictures
You can save pictures of windows such as Bird's-eye view, Stereograph, Orthographic projection 

map, etc.. Do "Save" under "File" menu when target picture window is in front.  You can specify 
file name and format in the file navigation dialog.

Always you saves pictures as new files, not update.
If the picture is 16 bits grayscale, you can select one of tiff or png.

Create world file
You can create world files to use pictures with some GIS software. You can specify creation in 

the saving dialog for Map picture, in the Preferences dialog for grayscale maps.
Pictures satisfying following three can attach a world file.

• DEMs should be one of Geo, UTM or other plane coordinate.
• Map pictures or grayscale pictures.
• File type is one of TIFF, JPEG, JPEG2000, PGN or BMP.

Format is the same as the HDR file for BIL form DEMs.

Extensions for world files are set as follows.  
TIFF - TFW, JPEG - JGW, JPEG2000 - j2w, PNG - PGW, BMP - BPW

Note. : Many GIS software supports TFW but others.

Save as GeoTiff
If you specify tiff format for saving map picture, it will be GeoTiff automatically when DEMs are 

geo-referenced, UTM or other planes.  Some GIS programs do not understand world file but Geo-
Tiff.

Also Grayscale map and SRVC relief map and anaglyph that face to north and one pane is right 
projection can be saved as GeoTiff.

You should aware that datum of this GeoTiff file is WGS84 always, even if DEMs are not based 
on WGS84.

Add GPS information
GPS information ( Latitude, Longitude and datum ) are added in the picture as exif GPS informa-

tion, when saving following pictures.  Picture type should be jpeg or tiff. Latitude and longitude 
are at the center of the picture.

Map View, Bird’s-eye view, Stereograph, Panorama view, Grayscale and projection maps.
Eye direction and elevation are also attached to Panorama views 

First line Horizontal data pitch in degrees or in meters.
Second line 0
Third line 0
4th line Vertical data pitch in degrees or in meters. Always minus value.
5th line Longitude at the center of the north-west corner cell of the data in degrees, or 

coordinate address of UTM or XYPLANE. 
6th line Latitude at the center of the north-west corner cell of the data in degrees, or 

coordinate address of UTM or XYPLANE.
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36. Remove Data
You can remove data those are read in this program by the di-

alog looks like picture at right. Select “Remove data…” under the 
“File” menu to show the dialog. “Remove data” means just re-
move from the program memory, not delete from disk storage.

The  dialog  lists  removable  data  such  as  DEMs,  User  Memo 
data, User Route data, User Area dat and texture maps in this 
order.
DEMs

You can select each kind of DEMs to remove them. No individ-
ual file is selectable.
User Memo / Route / Area data

You can select kinds or select all for each data type. If you want remove individual data, you 
should go Edit User Data dialog.

If new or updated data exist and not saved yet, an alert message will appear.
Texture maps

Remove all texture maps currently read. Individual texture map file can be removed through 
Texture Map dialog.

“Select all” button selects all items to remove all data.  You can use ⌘A shortcut key.
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37. Menus
Main Menu Bar

SimpleDEMViewer
About SimpleDEMViewer Show about dialog.
Preferences.. Show preferences dialog.
Quit SimpleDEMViewer

File
Open... Read DEMs and user data files.
Close Close picture windows and some panels.
Remove data... Remove DEMs and / or user data.
Save Picture As... Save the Map View or picture window as picture file.
Save Working Set… Save data and settings with or without name.
Load working set Load named working set. Saved names are listed in sub-menu.
Export DEM… Create new DEM file from read DEMs.
Manage Projection Planes… Define world’s local planar coordinate systems.
Manage color sets... Rename, remove color sets. Arrange color set menu items. 

Export color sets as external file.
Import color sets Read color set files and register them.
Show Info Show information panel for DEM or pictures.

Edit (only Copy and Paste have custom functions)
Undo
Redo
Cut
Copy Copy address from address control.
Paste Paste address to address control.
Delete
Select All
Special Characters...

View
Refresh Redraw map.
Expand Zoom in map.
Shrink Zoom out map.
Scale
  2000%  ~  5% Apply new scale to map.
  Other (nn%)... Specify custom scale to apply.
Adjust Base Latitude Set base latitude to center latitude of current Map View.
Window Size... Specify Map View size.
Show (Hide) Side Bar Show / Hide Map Information panel and Index Map.
Show (Hide) Scale Panel Show or hide scale panel.
Change to Vertical (Horizontal) Scale

Swap scale panel between vertical and horizontal.
Find&Jump

Find... Find a string in user data and reposition map.
Find Next Find another occurrence.
Jump to... Reposition map to the address specified.

User Data
Show/Hide User Data... Show dialog to set show / hide status.
Edit User Data... Show dialog with table of user data to editing.
Import Text User Data… Import text formed User Data.
User Data Preferences... Set defaults for user data, and maintaining user data kind.

Tools
Texture Maps... Read and set texture map.
Rectangle Region... Set or clear rectangle region on the Map View.
Find Highest/Lowest... Find highest or lowest elevation point in the read DEM.
Contour... Show a dialog to draw contour lines.
Slope Level... Show a dialog to colorize map by slope degrees.
Visible Region... Show a dialog to colorize map by Visible Region.
Bird’s Eye View... Show a dialog to create Bird’s-eye view picture.
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Panorama View... Show a dialog to create Panorama view picture.
Reset Panorama View Reset Panorama View settings to defaults.
Stereograph... Show a dialog to create Stereograph picture.
GeoProfile... Show a dialog to create geo-profile picture.
Projection Maps... Show a dialog to create projection maps.
Grayscale Map... Show a dialog to create Grayscale map.
SRVC Relief Map… Show a dialog to create SRVC relief map.
Create Lake Data... Start to create lake data.

Window
Minimize
Zoom
Bring all to front

Help
Online manual Show latest manual with safari ( or another browser ) through 

internet.
SimpleDEMViewer Help Show some faqs and topics in HelpViewer.

Context Menu on the Map View
Show this place in
  Maps.app Activate Maps and show this place in it. ( OS X 10.9 )
  Google Map Activate safari ( or other browser ) and retrieve Google map of 

this place.
Show DEM inspector Show DEM inspector panel showing cell values of DEM files.
Select Rectangle Region Start selecting rectangle region on the map.
Copy Address Copy address of the mouse point.
Centering Reposition map so that the mouse point will move to the map 

center.
Scale Change scale and Reposition map so that the mouse point will 

move to the map center.
  2000% ~ 5% Change the scale to the selected percentage.
  Other (nn%).. Change scale to any value.
Expand Expand map by changing scale one step larger in menu.
Shrink Shrink ,map by changing scale one step smaller in menu.
Create User Data
  Memo... Create memo data at the mouse point.
  Route... Start to create route data from the mouse point.
  Area... Start to create area data from the mouse point.
Measure Milage Start to measure milage from the mouse point.
Create Panorama View... Start to create panorama view as you are on the mouse point.
Set to panorama View Target Set the mouse point as the target of panorama view.
Draw Visible Region... Show dialog to draw visible region and set the mouse point as 

the target.
Create Projection Map... Show dialog to create projection maps and set the mouse point 

as the map center.
Place nnn to all cells in frame During DEM Inspector panel showing, set all cells in the se-

lected rectangle on Map View to same value "nnn".

Context Menu on Panorama View
Set to Target Set the mouse point as the target.
Set to Eye Point Set the mouse point as the eye point and show creation dialog.
Set to Eye Point and Look back

Set the mouse point as the eye point, set the previous eye 
point as the target and show creation dialog.

Show Place in Map View Reposition map so that the mouse point place move to the 
center.

Add (Edit) String... Add new string or update pointed string on the panorama 
view.

101



SimpleDEMViewer

38. Limitations for AS Version

All App Store programs are required sandboxing, because of that some limitations are added 
comparing to SimpleDEMViewer V7.  Following list shows all of them.

• Does not support DEMs from GSI of Japan, those have file extension ‘LEM’.
• You should select folders instead of individual files for SDTS, JAXA ALOS DEMs.
• To recognize sea region of GDEM version 3, you should select folder includes both DEM and 
sea information file.

• All tiff format files can be selected by Open panel even if those files are not DEM files.  They 
will be checked after you close the panel.  netCDF files those have file extension ‘GRD’, and 
PDS DEM files those have file extension ‘IMG’ are the same.  Also bil form files are checked lat-
er if HDR file is exists or not.

• Cannot read alias files even they point DEM files if you select folders. You should select indi-
vidual files for aliases.

• Topographic maps from GSI of Japan is just treated as normal pictures as a texture maps.
• User Memo Data cannot show pictures, if referencing pictures reside outside Memo Library.
• Closing the main window terminates application.
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